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List of Abbreviations

PMO: Project Management Office

ECC: Emergency Command, Control & Communication center
PC: Project Charter

M & C: Monitoring & Controlling

OBS: Organizational Breakdown Structure

EPS: Enterprise Project Structure

TFU: Treated Fresh Air Units

AHU: Air Handling Units

FCU: Fan Coil Units

CU: Condensing Units

SP: Static Pressure

BHP: Brake Horse Power

PPIC3: Punjab Police Integrated Command, Control & Communication Center
PSCA: Punjab Safe Cities Authority

SV: Schedule Variance

ETC: Estimate to Complete

EAC: Estimate at Completion

BAC: Budget at Completion

ACWRP: Actual Cost of work performed

BCWP: Budgeted cost for work performed

BCWS: Budgeted cost for work Scheduled
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Preface

As a requirement of MSPM program, and to practically implement the knowledge of
Project Knowledge in the field, we are required to make a comprehensive report which
will consist of two parts.

In first part of this report Corporate Information will be provided regarding the organization
that is MECSOL Engineering Services & will discuss the project overview & charter, EPS
(Enterprise Project Structure) & OBS (Organizational Breakdown Structure). One of them
is “A project management office, abbreviated to PMO, is a department within a business,
agency or organization that defines and maintains standards for project management

within the organization”

In second part scheduling, costing, S-Curves of a selected project i.e. Punjab Police
Integrated Command, Control & Communication Center located at Qurban Lines, Lahore

is performed a number of reports are generated. This is done by Primavera P6.
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7. Project Overview

7.1) PPIC-3:

In order to realize the vision of developing safe cities in the province, PPIC3 Centre has
been developed for Punjab Police in the city of Lahore, which will be subsequently
established in the larger cities of the province. [1]

PPIC3 LAHORE

7.2) ECC, Lahore:

EEC (Emergency Command, Control & Communication center) is located in Qurban
police lines, Lahore to monitor the terrific, Law & order situation overall the city through
high definition & face recognition cameras. The Air conditioning of the building is all done

but some equipment is remaining like AHU, TFU & FCU. That need to be installed now.

7.3) Project Phase:

Basically this project is in execution phase, but this part of the project on which | am
working going to be start from January 1%, 2018 so we adding some best scenarios &
worst scenarios of the project on S-Curves as per requirement of the course.

7.4) Client:

The project is sponsored & owned by Govt. of the Punjab with Collaboration of Punjab

Police for the beginning of a new Police culture in Punjab.

PUNJAB POLICE
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7.5) Main Contractors:

The Project was awarded to Huawei Technologies & INBOX Business Technologies.

=
~ inbox
gré H UAWE I ¢ Providing agilityfc:; th-;e digital age™

7.6) Sub-Contractors:

Due to the high Pace of work & to meet the project timelines, the project is further awarded

to different Sub-Contractors.

1) Electrical Contractors

Lo

" 2PSPS Pwvt. Lta.

Engineers & Constructors

2) Civil Contractor

E-| U.C.C

(Private) Limited

3) HVAC Contractor

MECSOL

P A KISTAN
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4) Fire Fighting Contractor

# FIRETECH

ENTERPRISES (PVT) LTD.

7.7) Consultants:

The Consultancy services are provided by two main Consultants. One from Huawei’s Side
(AL-IMAM Enterprises) for the design of the building. Other one is from Punjab Police
side (NESPAK) to make sure the quality delivery of services. One third party consultant
is hired for the audit of the project.

NATIONAL ENGINEERING

somdl

INFRASTRUCTURE
DEVELOPMENT
AUTHORITY
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8. Corporate Information

MECSOL Delivers EPC Solutions for Clients around Pakistan. MECSOL company,
delivers integrated engineering, procurement, construction (EPC), maintenance and
project management solutions to governments and private sector Clients in diverse
industries around the world. MECSOL develops and implements innovative solutions for
complex project issues. For over a decade, Clients selected MECSOL as their company
of choice to complete challenging projects in remote parts of the world. We are multi-
disciplinary engineering organization operating in Pakistan since 2008. [2]

8.1) CEO Message:

We are one of the Pakistan's emerging engineering company employing skilled

professionals and administrative support staff.

Our aim is simple - we want to be the best. Within the MECSOL family, we want to be
one of the leading operating company. The incredible project opportunities currently

available in the Pakistan will make this goal possible.

We want to be seen as the company of choice by our Clients. But even more, we want to
be considered their trusted advisor, capable of delivering a product on time, on budget

and we hope, beyond their expectations.

Finally, we want to be the employer of choice in the Pakistan. We recognize that behind
each of our projects is the expertise and efforts of our employees, so we ensure that they
are treated fairly, are offered opportunities for career growth opportunities and

development and are well rewarded for their commitment.

8.2) \Vision:

Be the world’s premier engineering, construction, and project management organization
by achieving extraordinary results for our customers, building satisfying careers for our

people, and earning a fair return on the value we deliver.
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8.3) Leadership:

The role of leadership is central to MECSOL's mission of successfully delivering projects
in a safe, efficient and economical manner. MECSOL's team of leaders brings solid

experience and a firm commitment to Clients.

8.4) Ethics & Compliance

MECSOL is committed to the highest standard of ethical business conduct around the

world.

MECSOL is committed to the highest standard of ethical business conduct around the
world. This ethical standard is one of the company's most valuable assets and is a direct

result its employees conduct.

MECSOL will conduct all business transactions in a proper, fair, impartial, and ethical
manner, avoiding even the appearance of impropriety. We seek customers and partners

who share our values and standards of conduct.

MECSOL Head Office

1st Floor,5-L Commercial Area, Phase-1 D.H.A, Lahore,Pakistan
info@mecsolpk.com
+92-4235722134-35

https://www.mecsolpk.com
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9. Introduction to Primavera P6

9.1) What is Oracle Primavera P6?

Oracle Primavera P6 is an integrated project portfolio management (PPM) solution
consisting of role-specific tools to satisfy each team member’s needs, responsibilities,
and skills. The P6 suite uses a standard Windows interface, client/server architecture,
Web-enabled technology, and a stand-alone (Oracle XE) or network-based (Oracle and
Microsoft SQL Server) database. [3]

9.2) Project Management (PM)

The Project Management module enables users to track and analyze performance. It is
a multiuser, multi-project system with scheduling and resource control capabilities
supporting multi-tiered project hierarchies, resource scheduling with a focus on roles and

skills, recording of actual data, customizable views, and user-definable data.

The module is ideal for organizations that need to simultaneously manage multiple
projects and support multiuser access across a department or the entire organization. It
supports an enterprise project structure (EPS) with an unlimited number of projects,
activities, baselines, resources, work breakdown structures (WBS), organizational
breakdown structures (OBS), user-defined codes, and critical-path method (CPM)

scheduling and resource leveling.

9.3) Planning, Controlling, and Managing Projects

Before implementing P6 to schedule projects, team members and other project
participants should understand the processes involved in project management and the
associated recommendations that help smooth the implementation that best supports

your corporate mission. [4]

If you were driving to a place you had never seen, would you get in the car without
directions or a map? Probably not. More than likely you’d take the time to plan your trip,
consider alternate routes, and estimate your time of arrival. Planning the drive before you

even left would help your trip be more successful. And, along the way, should you
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encounter road blocks or traffic delays, you would have already identified alternate ways

to reach your destination.

Project management follows the same methodology and purpose; to achieve each
project’s goals, you need to plan them in advance. Good project management is no longer
an option in today’s corporate world. It is a critical tool to help your company stay on target

and accomplish its goals.

Simply stated, project management is the process of achieving set goals within the
constraints of time, budget, and staffing restrictions. It allows you to get the most out of

your available resources. Resources include

e People

e Materials

e Money

e Equipment

e Information
e Facilities
e Roles

The process of project management is guided by three key principles:

¢ Planning
e Controlling

e Managing
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10. EPS & OBS

Table A: OBS stands for Organizational Breakdown Structure. The OBS for MECSOL
Engineering Services is listed below

PPIC3 PROJECT EXECUTION PLAN | All OBS Elements | 29-Dec-17 19:18
OBS Name |
B Enterprise
"B ceo
"B DGMSALE
 MANAGER BD-SOLAR DI
MANAGER BD-POWER
- MANAGER BD-CIVIL
£ PROJECT ENGINEER
I KEYACCOUNT EXECUTI
£ APPLICATION AND DESII
“MANAGER FINANCE/ACCO

I

- COMMERCIAL OFFICER

n

.
B GRAPHIC EXECUTIVE
5 BRAND EXECUTIVE
"PATO CEO
| OFFICE BOY
_ FRONT DESK OFFICER
ROJECT MANAGER
 SITE ENGINEER
I STORE OFFICER

=1

2

T | 2 T 1 §

ROJECT ENGINEER PL
~ SITE SUPERVISOR
~ AUTOCAD OPERATOR
irector Technical Educatior

B

o M

l Additional Director Industrial
Joint Director Industrial Trait
Deputry Director Administrati
Deputry Director Training ani
Deputy Director CEO
Deputy Director IDT
Deputry Director SDI
Deputy Director Control
Deputy Director Planing
E&C
Energy
~ Manufacturing
ProdDev
~ ProdProg1
~ ProdProg2
_ Corporate

In Flight
Pipeline

19513191913193135:513159

- I
o T 11

|

T T |

© Oracle Corporation Page 1 of 1
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Table B: EPS stands for Enterprise Project Structure. The EPS for MECSOL Engineering

Services is listed below

<) Public Health
< HVAC Design
B Electrical
<% Electrical Design
<» BMS
) Electrical Execution
<% Mechanical
< Plumbing
< Firefighting
{} Enterprise
< Energy
<% Manufacturing
<% ProdDev
<3 ProdProg1
<» ProdProg2
<% Corporate
<3 In-flight
< Pipeline
o IT
< LOBA1
< LOB2

Severage & water pipe lines
Designing

Electrical work

Design

Building Management System
Execution

Mechanical Work

Plumbing Work

Fire Fighting

Al Initiatives

Energy Services
Manufacturing

Product Development
Product Program 1

Product Program 2
Corporate Programs
In-flight Projects

Proposed Opportunties
Information Technology
Line of Business 1

Line of Business 2

PPIC3 Final EPS 02-Jan-18 00:12
EPS ID | EPS Name
<» MECSOL MECSOL EPS
Zh Civil PPIC3 Lahore
<% Environment (New EPS)
<» HVAC Heat Ventilation & Air Conditioning
<p PPIC3 Punjab Police Command Control Center

© Oracle Corporation

Page 1 of 1
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11. PMO (Project Management Office)

PMO is an organizational body assigned various responsibilities related to the centralized
and coordinated management of those projects under its domain and it has various roles

in an organization. [5]

Role of the PMO in MECSOL Engineering Services

1) Provide the SOP / Standards / Policies for the better execution of projects.

2) Provide templates

3) Better communication management & Coordination with stakeholders

4) To provide best practices & trainings

5) Proper Monitoring & Controlling of the projects

6) Proper reporting of project status to CEO.

7) Coordinate between projects.

8) Selection of new projects.
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PROJECT CHARTER

pPIC3 LAHORE

b

MECSOL

P AKISTAN

N2 Huawer 7)

Project Name: PPIC3, Lahore
Project Manager: Mr. Syed Aijaz

Mr. Syed Aijaz
Project Manager
Mr. Fahad Arif

Planning & Coordination Engineer

Release Date: December 10, 2017

Version: 0
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Project Charter Document History

Document Revisions:

Author Release Date s Version Approval
Changes Signatures
Fahad Arif December 10, N/A 0

2017

Project Charter Distribution History

This project charter has been distributed to:

Distribution Distributed | Recipient

Name Project Role Date Version | Signature

December 10,

2017 0

Mr. Naseer Ahmed Project Sponsor
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Project Statement of Work

Why this project is being done?

The installation of AHUs (Air Handling Units), TFUs (Treated Fresh Air units) FCUs
(Fan Coil Units) for the purpose of Air Conditioning of building, where the
monitoring of Lahore city will be made.

Project Manager Authority Level

e Project Manager can determine, manage, and approve changes to the budget,
scope, staffing and schedule.

e Project Manager can make use of company extra resources to complete the
project.

e Project Manager can change the team’s roles and responsibilities throughout the

life cycle of the project.

Project Objective Success Criteria Person
Approving

Scope: Installation of AHUs, To complete the project | Project Sponsor
TFUs & FCUs in ECC | without Scope Creep
Building, Lahore

Time: 61 Days To Complete the project | Project Sponsor
within Time
Cost: Rs: 376,220,000/- To complete the project | Project Sponsor

within Budget
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Project Scope

Situation / Problem / Opportunity

The Scope will cover the design, manufacture, supply, installation, storing, safety,
operation & maintenance, testing, commissioning, performance testing of the
TFUs, AHUs & FCUs System for the Emergency Command Control &
Communication Center Lahore, complete in every respect & suitable for safe,
efficient and reliable operation.

Deliverables

¢ |Installation of Fan Coil Units (FCUs)

¢ |Installation of Air Handling Units (AHUSs)

¢ |Installation of Treated Fresh Air Units (TFUs)
¢ Installation of Condensing Units

e Installation of Electrical Panels

Project Assumptions

The project martials can be bought only from vendor approved by Client's
consultant & Project Sponsor.

Risks and Dependencies

e Delay in the availability of project staff and technical resources may delay the
timeline of this project.
¢ Delay in major equipment can be a reason for the delay.

High Level Deliverables

The High Level Deliverables are as under:
e Design

¢ Installation

e Acceptance

Major Milestones

The project milestones are as under:
1. Installation of AHU — 01
Installation of AHU — 02
Installation of AHU — 03 & 04
Installation of AHU — 05
Installation of AHU — 06 & 07
Installation of TFUs

2
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7. Installation of FCU — Staff Training Center 1

8. Installation of FCU — Staff Training Center 2

9. Installation of FCU — Dining Room

10. Installation of FCU — LT Room

11.Installation of FCU — Staging Room

12.NESPAK Inspections & Approval (AHU — 01)

13.NESPAK Inspections & Approval (AHU — 02)

14.NESPAK Inspections & Approval (AHU — 03 & 04)

15.NESPAK Inspections & Approval (AHU — 05)

16.NESPAK Inspections & Approval (AHU — 06 & 07)

17.NESPAK Inspections & Approval (FCU — Staff Training Center 1)
18.NESPAK Inspections & Approval (FCU — Staff Training Center 2)
19.NESPAK Inspections & Approval (FCU — Dining Room)
20.NESPAK Inspections & Approval (FCU — LT Room)

21.NESPAK Inspections & Approval (FCU — Staging Room)
22.NESPAK Inspections & Approval (TFUs)

Time

The proposed time for this project is 61 days

Budget

The baseline budget for this project is PKR 376,220,000/-

PROJECT ROLES & RESPONSIBILITIES

Table C: The roles and responsibilities of key project stakeholders.

Name Project Role Contact info Signature
. Project
Mr. Akbar Nasir Sponsor/Owner
Project Director
Mr. Muhammad Azam (HUAWEI)
Project Director
Mr. Naseer Ahmed (MECSOL)
.. Project Manager
Mr. Aijaz Shah (MECSOL)
Planning
Mr. Fahad Arif Engineer
(MECSOL)
. Site Supervisor
Mr. Zahid Sarwar (MECSOL)
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Project Charter Approval

The undersigned acknowledge they have reviewed the project charter and authorize
/appoint Mr. Syed Aijaz to undertake responsibility of leading the project in capacity of
project manager and approve his authority to carry out tasks as defined earlier in the
document. He is also authorized to pre-approve budget revisions up to PKR 2,500,000/-
Increases greater and these changes to this project charter will be coordinated with and

approved by the undersigned or their designated representatives.

Signature:

Name: Mr. Naseer Ahmed
Role: Project Director
Dated:
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PROJECT SCOPE STATEMENT

pPIC3 LAHORE

b

MECSOL
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N2 Huawer 7)

Project Name: PPIC3, Lahore
Project Manager: Mr. Syed Aijaz

Mr. Syed Aijaz
Project Manager
Mr. Fahad Arif

Planning & Coordination Engineer

Release Date: December 16, 2017

Version: 0
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Project Scope Statement

Version:
Version Issue date | Approved Approval Changes | Completed
By Date By
0 December Project December 19, - Fahad Arif

16, 2017 Manager 2017

Introduction:

Air Handling Units:

The AHUs Shall complete with Drivers, Motors & Belts. These shall include Mixing Box

with Dampers, Filters & Humidifiers when scheduled. [6]

Treated Fresh Air Units:

All TFUs shall complete with Variable drives, motors, and belts. These shall include
mixing box with dampers, filters and humidifiers when scheduled.

Fan Coil Units:

All FCUs shall be of make & Country of manufacture similar to AHUs unless otherwise

approved by Project Sponsor.

Objectives:

For purpose of calculation of motor BHP, specified external SP and AHU manufacturer's
internal SP should be added. Filter pressure drop shall be part of internal SP, which shall
be calculated on average of clean (initial) and filter manufacture-recommended dirty
(final) pressure drop. Published recommendation of filter manufacturer shall be furnished
along with technical submittal. In case published recommendation is not available, a
recommendation on the printed stationery of filter manufacturer shall be acceptable
provided the manufacturer certified that no such published data is available. Motor HP
shall be at least 120% of calculated BHP.

The Eurovent / AHRI certified air handling units shall meet the requirements of ARI
430-86 and ASHRAE 51-85 standards and shall be factory tested according to the

requirements of the these standards
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Major Deliverables:

Installation of Fan Coil Units (FCUs)
Installation of Air Handling Units (AHUSs)
Installation of Treated Fresh Air Units (TFUs)
Installation of Condensing Units

Installation of Electrical Panels

Start Milestones:

The project milestones are as under:

1.

©CoNoOORWDN

Installation of AHU — 01

Installation of AHU — 02

Installation of AHU — 03 & 04

Installation of AHU — 05

Installation of AHU — 06 & 07

Installation of TFUs

Installation of FCU — Staff Training Center 1
Installation of FCU — Staff Training Center 2
Installation of FCU — Dining Room

10 Installation of FCU — LT Room
11.Installation of FCU — Staging Room

Finish Milestones:

12.NESPAK Inspections & Approval (AHU — 01)

13.NESPAK Inspections & Approval (AHU — 02)

14.NESPAK Inspections & Approval (AHU — 03 & 04)

15.NESPAK Inspections & Approval (AHU — 05)

16.NESPAK Inspections & Approval (AHU — 06 & 07)

17.NESPAK Inspections & Approval (FCU — Staff Training Center 1)
18.NESPAK Inspections & Approval (FCU — Staff Training Center 2)
19.NESPAK Inspections & Approval (FCU — Dining Room)
20.NESPAK Inspections & Approval (FCU — LT Room)

21.NESPAK Inspections & Approval (FCU — Staging Room)
22.NESPAK Inspections & Approval (TFUs)

Constraints:

Area are operational, we have to work by swapping the staff.

To meet the timelines, we have to deploy the additional resources.

Wall opening & Ceiling openings will be required in some area to place Fan Coil
Units, Ducts, Drain/MS pipes & Power Cables.
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Exclusions:

e Foundation work for the Placement of Air Handling Units.
e Foundation work for the Placement of Treated Fresh Air Units.
e Foundation work for the Placement of Condensing Units.

e Epoxy Paint in AHU Rooms

Technical Requirements & Specifications

Air Handling Units & Treated Fresh Air Units

1)

2)

3)

4)

S)

6)

7

8)

These shall be factory assembled draw-through packaged air handling unit of
capacities and characteristics as required. Air handling units shall be horizontal or
vertical with component and configuration.

Large AHUs may be shipped in sections e.g. Fan Coil Section, filter section, mixing
box section for ease of transportation and rigging.

Coils shall be of copper construction with mechanically bonded smooth aluminum
fins, suitable for chilled water and hot water applications.

Fan shall be double inlet centrifugal (Backward/Airfoil) mounted on a common shaft.
Fan impeller shall be statically and dynamically balanced and shall have permanently
lubricated bearings. Fan shall be belt driven with adjustable sheaves.

Fan motor shall be variable frequency drive (VFD) capable of modality by
standalone control unit in AHU room as well as compatible with CONTROL SYSTEM.
Fan shall have spring isolation from the casing.

Casing shall be made of sheet steel and finished with baked enamel. (Or approved
by the Engineer) The casing shall be double skin with minimum 1-1/2 inch thermal
insulation between the skins and removable panel type. AHU shall be equipped with
factory fabricated filters and filter boxes with side access door.

A condensate drain pan, with double wall construction and insulation in between,
shall be provided. Inner pan shall be finished with a factory applied coating of
corrosion resistant material. Insulation, adhesive and inner coatings shall comply
with NFPA-90A Standard. Other types of drain pans shall be acceptable.

Flat filters installed in Air Handling Units, shall be permanent, impingement, dry type,

washable, all metal, panel type, at least 2 inch thick unless otherwise scheduled.
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Media shall be aluminum screen, arranged in alternate layers of flat and
herringbone-crimp, 4 layers of each per one inch reinforced and enclosed in a frame
of 16 gauge galvanized steel with flush mitered corners. Initial pressure drop at 500
FPS shall not exceed 0.1 inch WG. Holding frame shall be factory-built of 16 gauge
steel; with felt air seal. Filters shall have at least 35% efficiency on 0-5 microns range
when tested in accordance with ASHRAE Standard 52-76.

Bag filter (if schedule) in AHUs shall be extended surface dry type non-supported
pocket, cartridge filter. Average efficiency shall not be less than 90% when tested
as per ASHRAE standard 52. Initial resistance at 500 FPS shall not exceed 2

inch.

10) Humidifiers shall be self-contained electric resistance heated type, steam humidifier

of capacities as given in equipment schedule, and shall be suitable for unit and/or
duct installation. The resistance heater shall be designed for upto 90 watts per
square inch. Design of heater shall provide for expansion and contraction. Water
Make-up valve shall be solenoid operated, brass body type. A cleanable strainer
with, fine mesh screen shall be mounted upstream of valve. Combination low water
cut off and water make up valve controller shall be of the electrode probe type. The
humidifier shall utilize an adjustable surface skimmer arranged so that on each refill
cycle, a portion of the humidifier water will flow to drain. The chamber shall be
provided with a bolted cover, clean out opening in the front face, for periodic removal
of loose scale, factory fitted, and shall contain magnetic contactors, control circuit
transformer, logic control system module numbered terminal strip and all
interconnecting wiring Control Module shall be solid state and shall provide for
automatic refill, automatic-reset, low water cut off and manual surface flushing

through the surface skimmer.

Fan Coil Units

1) Unit shall be of blow-through design and shall be wall mounted/ceiling-hung
type/concealed type/cassette type as scheduled complete with combination
hot/chilled water coil, motor(s), fan(s) and drain pan. The unit shall have one or
more quiet operating centrifugal fans directly connected to extend motor shafts.

Motor fan assembly shall be easily detachable from coil section. The coil and drain
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pan shall be readily reversible. The coil shall be supplied with drains and vent
cocks so located as to permit drain and vent of coil regardless of position. The fan
and motor assembly shall be readily removable and shall be provided with a quick
disconnect on the motor chord.

Unit motor shall be of capacitor run type with at least three speeds of operation.
Motors shall be equipped with oil cups for lubrication with the oil cups located for
easy accessibility.

Fan coil rating shall be such that after considering room effect, the sound level
shall not exceed NC rating specified in special provision in second through 8th
octave band. Calculation of sound pressure level shall be submitted by the
Contractor to the Engineer for his approval.

Filters installed in FCU (if scheduled) shall be permanent impingement dry type,
washable all metal, penal type at least 'z inch thick. Media shall be aluminum clean
arranged in alternate layers of flat and herring bone- crimp, reinforced and
enclosed in a 16 gauge G.I. Frame with flush mitered corners. Initial pressure drop
at 500 FPS shall not exceed 0.05 inch WG. FCU thermostat shall be digital type
with LCD display of room temperature. FCU controls shall be preferably supplied

by the manufacturer.
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Table D

STAKEHOLDER REGISTER @ hyawer

Name Internal/External Project Role Contact No.
CM Punjab External Project
Sponsor
Mr. Akbar Nasir External Project
Khan Champion
Mr. Ali Shamshair External Project
Director
(PSCA)
Mr. Faisal Naseem External Project
Director
(HUAWEI)
Mr. Muhammad Internal Project
Azam Manager
(HUAWEI)
Mr. Haris Shamsi External Vice
President
(INBOX)
Mr. Bakhat Jamal Internal Project
Director
(INBOX)
Mr. Ali Raza Internal Project
Manager
(INBOX)
Mr. Ali Hamid Internal Resident
Engineer
(AL-IMAM)
Mr. Ahmed Internal Chief
Resident
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Engineer
(NESPAK)

Mr. Naseer Ahmed

Internal

Project
Director
(MECSOL)

Mr. Aijaz Shah

Internal

Project
Manager
(MECSOL)
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Project Name: PPIC3, Lahore
Project Manager: Mr. Syed Aijaz

Mr. Syed Aijaz
Project Manager
Mr. Fahad Arif

Planning & Coordination Engineer

Release Date: December 21, 2017

Version: 0
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Serial #  Activity ID Activity Name

1 A1070 Training Room 1 - FCU :

2 A1080 Ceiling Cutting / Dismantling & Installation of FCU

3 A1090 Installation of Valves and MS Pipe Connections

4 A1100 Electrical Termination

5 A1110 Insulation of Duct and Pipes

6 A1120 Ceiling / Ceiling Repairing

7 A1130 Installation of Lights

8 A1140 Installation of Smoke Detector / Sprinkler

9 A1150 Linear Grill Alignment

10 A1160 Nespak Inspection and Approval

11 A1170 Training Room 2 - FCU :

12 A1180 Ceiling Cutting / Dismantling & Installation of FCU

13 A1210 Installation of Valves and MS Pipe Connections

14 A1220 Electrical Termination

15 A1230 Insulation of Duct and Pipes

16 A1240 Ceiling / Ceiling Repairing

17 A1250 Installation of Lights

18 A1260 Installation of Smoke Detector / Sprinkler

19 A1270 Linear Grill Alignment

20 A1280 Nespak Inspection and Approval

21 A1290 Dining Area - FCU :

22 A1300 Ceiling Cutting / Dismantling & Installation of FCU

23 A1310 Installation of Valves and MS pipe Connections

24 A1320 Electrical Termination

25 A1330 Insulation of Duct and Pipes

26 A1340 Ceiling / Ceiling Repairing

27 A1350 Installation of Lights
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28 A1360 Installation of Smoke Detector / Sprinkler
29 A1370 Linear Grill Alignment
30 A1380 Nespak Inspection and Approval
31 A1390 Staging Room - FCU :
32 A1400 Ceiling Cutting / Dismantling & Installation of FCU
33 A1430 Installation of Valves and MS Pipe Connections
34 A1440 Electrical Termination
35 A1450 Insulation of Duct and Pipes
36 A1460 Ceiling / Ceiling Repairing
37 A1470 Installation of Lights
38 A1480 Installation of Smoke Detector / Sprinkler
39 A1490 Linear Grill Alignment
40 A1500 Nespak Inspection and Approval
41 A1510 LT Room- FCU :
42 A1520 Hanging arrangement and Unit Placement
43 A1530 Fabrication and Installation of Duct Work
44 A1540 Installation of Valves and MS Pipe Connections
45 A1550 Electrical Termination
46 A1560 Insulation of Duct and Pipes
47 A1570 Nespak Inspection and Approval
48 A1580 Roof Top TFUs : (5 Nos)
49 A1600 Shifting and Placement of Units on Foundations at Roof
50 A1610 Duct Work
51 A1620 Copper Piping
52 A1630 Installation of Cable Trays
53 A1640 Laying and Termination of Power Cables
54 A1660 Insulation of Duct work and Pipes
55 A1670 Nespak Inspection and Approval
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56 A1680 AHU - 01 (Basement)
57 A1700 Shifting of Unit at location
58 A1720 Installation of SA
59 A1730 Assembly of AHU Sections
60 A1740 Fabrication and Installation of MS Pipe and Valves
61 A1750 Installation of Cable Trays
62 A1760 Laying and Termination of Power Cables
63 A1770 Installation of VCD & FD in Supply & Return Ducts
64 A1780 Installation of Humidifier
65 A1790 Fabrication and Installation of Duct Work
66 A1810 Insulation of Duct work and Pipes
67 A1820 Nespak Inspection and Approval
68 A1830 AHU - 03 & 04 (Ground Floor)
69 A1860 Shifting of Unit at location
70 A1880 Installation of SA
71 A1890 Shifting & Placement of Units on Location
72 A1900 Assembly of AHU Sections
73 A1910 Fabrication and Installation of MS Pipe and Valves
74 A1920 Installation of Cable Trays
75 A1930 Laying and Termination of Power Cables
76 A1940 Installation of VCD & FD in Supply & Return Ducts
77 A1950 Installation of Humidifier
78 A1960 Fabrication and Installation of Duct Work
79 A1980 Insulation of Duct work and Pipes
80 A1990 Nespak Inspection and Approval
81 A2000 AHU - 06 & 07 (First Floor)
82 A2020 Placment of Units at Foundation
83 A2040 Installation of SA
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84 A2050 Assembly of AHU Sections
85 A2060 Fabrication and Installation of MS Pipe and Valves
86 A2070 Installation of Cable Trays
87 A2080 Laying and Termination of Power Cables
88 A2090 Installation of VCD & FD in Supply & Return Ducts
89 A2100 Installation of Humidifier
90 A2110 Fabrication and Installation of Duct Work
91 A2130 Insulation of Duct work and Pipes
92 A2140 Nespak Inspection and Approval
93 A2150 AHU - 02 (First Floor)
94 A2170 Shifting & Placement of Units on Location
95 A2190 Installation of SA
96 A2200 Assembly of AHU Sections
97 A2210 Fabrication and Installation of MS Pipe and Valves
98 A2220 Installation of Cable Trays
99 A2230 Laying and Termination of Power Cables
100 A2240 Installation of VCD & FD in Supply & Return Ducts
101 A2250 Installation of Humidifier
102 A2260 Fabrication and Installation of Duct Work
103 A2280 Insulation of Duct work and Pipes
104 A2290 Nespak Inspection and Approval
105 A2300 AHU - 05 (Ground Floor)
106 A2320 Wall Dismantling
107 A2330 Shifting & Placement of Units on Location
108 A2350 Installation of SA
109 A2360 Assembly of AHU Sections
110 A2370 Fabrication and Installation of MS Pipe and Valves
111 A2380 Installation of Cable Trays
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112 A2390 Laying and Termination of Power Cables
113 A2400 Installation of VCD & FD in Supply & Return Ducts
114 A2410 Installation of Humidifier
115 A2420 Fabrication and Installation of Duct Work
116 A2440 Insulation of Duct work and Pipes
117 A2450 Nespak Inspection and Approval

Table E: Activity List

(*) Highlighted ones are start & finish milestone activities.
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Project Name: PPIC3, Lahore

Project Manager: Mr. Syed Aijaz

Mr. Syed Aijaz
Project Manager
Mr. Fahad Arif

Planning & Coordination Engineer

Release Date: December 23, 2017
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PPIC3 Final

Classic Schedule Layout

| 01-Jan-18 13:06

Activity ID .Activity Name Original. Remaining. Schedule % | Budgeted Total Cosl| Start [Finish Total| Actual Labor Dec 03 Dec 10 Dec 17 Dec 24
DwiEden|| - DUEiE|  CeipEe P Cost|"Eri T sat | Sun [Mon | Tue [Wed] Thr | Fri | Sat | Sun | Mon| Tue [Wed] Thr | Fri | Sat | Sun | Mon | Tue [Wed] Thr | Fri | Sat | Sun [Mon] Tue [Wed] Thr [Fri
- PRO.J-4 PP 6 6 0% | PKR376,220,000.00| 01-Jan-18 6-Mar-18 0 PKR0.00
& A1070 Training Room 1 - FCU : 0 0 0% PKR0.00 01-Jan-18 61 PKRO0.00
‘ @ A1080 Ceiling Cutting / Dismantling & Installation of FCU 3 3 0% PKR?7,260,000.00 01-Jan-18 | 03-Jan-18 0 PKRO0.00
‘ & A1090 Installation of Valves and MS Pipe Connections 2 2 0% PKR60,000.00 04-Jan-18 | 05-Jan-18 0 PKRO0.00
‘ & A1100 Electrical Termination 1 1 0% PKR460,000.00 08-Jan-18 | 08-Jan-18 0 PKRO0.00
‘ @ A1110 Insulation of Duct and Pipes 1 1 0% PKR860,000.00 09-Jan-18 | 09-Jan-18 0 PKRO.OO|
‘ & A1120 Ceiling / Ceiling Repairing 1 1 0% PKR60,000.00 10-Jan-18  10-Jan-18 0 PKRO0.00
‘ & A1130 Installation of Lights 1 1 0% PKR460,000.00 11-Jan-18  11-Jan-18 0 PKRO0.00
‘ @ A1140 Installation of Smoke Detector / Sprinkler 1 1 0% PKR460,000.00 12-Jan-18 | 12-Jan-18 0 PKRO0.00
‘ @ A1150 Linear Grill Alignment 1 1 0% PKR60,000.00 15-Jan-18  15-Jan-18 0 PKR0.00
‘ @ A1160 Nespak Inspection and Approval 0 0 0% PKRO0.00 15-Jan-18 50 PKRO.OO|
\ & A1170 Training Room 2 - FCU : 0 0 0% PKR0.00 01-Jan-18 61 PKRO0.00
‘ @ A1180 Ceiling Cutting / Dismantling & Installation of FCU 3 3 0% PKR7,300,000.00 01-Jan-18 | 03-Jan-18 17 PKRO0.00
‘ @ A1210 Installation of Valves and MS Pipe Connections 2 2 0% PKR100,000.00 04-Jan-18 | 05-Jan-18 17 PKRO0.00
‘ @ A1220 Electrical Termination 1 1 0% PKR500,000.00  08-Jan-18 | 08-Jan-18 17 PKRO0.00
‘ @ A1230 Insulation of Duct and Pipes 1 1 0% PKR900,000.00 09-Jan-18 | 09-Jan-18 17 PKRO.OO|
‘ & A1240 Ceiling / Ceiling Repairing 1 1 0% PKR100,000.00 10-Jan-18 | 10-Jan-18 17 PKRO0.00
‘ @ A1250 Installation of Lights 1 1 0% PKR500,000.00 11-Jan-18  11-Jan-18 17 PKRO0.00
‘ @ A1260 Installation of Smoke Detector / Sprinkler 1 1 0% PKR500,000.00 12-Jan-18 | 12-Jan-18 17 PKRO0.00
‘ @ A1270 Linear Grill Alignment 1 1 0% PKR100,000.00  15-Jan-18 | 15-Jan-18 17 PKRO0.00
‘ @ A1280 Nespak Inspection and Approval 0 0 0% PKRO0.00 15-Jan-18 50 PKRO.OO|
‘ & A1290 Dining Area - FCU : 0 0 0% PKR0.00 16-Jan-18* 61 PKRO0.00
‘ @ A1300 Ceiling Cutting / Dismantling & Installation of FCU 3 3 0% PKR7,260,000.00 16-Jan-18 | 18-Jan-18 0 PKR0.00
‘ @ A1310 Installation of Valves and MS pipe Connections 2 2 0% PKR60,000.00 19-Jan-18  22-Jan-18 0 PKRO0.00
‘ & A1320 Electrical Termination 1 1 0% PKR460,000.00 23-Jan-18 | 23-Jan-18 0 PKRO0.00
‘ @ A1330 Insulation of Duct and Pipes 1 1 0% PKR860,000.00 24-Jan-18 | 24-Jan-18 0 PKRO.OO|
‘ & A1340 Ceiling / Ceiling Repairing 1 1 0% PKR60,000.00 25-Jan-18  25-Jan-18 0 PKRO0.00
‘ @ A1350 Installation of Lights 1 1 0% PKR460,000.00  26-Jan-18 | 26-Jan-18 0 PKRO0.00
‘ @ A1360 Installation of Smoke Detector / Sprinkler 1 1 0% PKR460,000.00 29-Jan-18 | 29-Jan-18 0 PKRO0.00
‘ & A1370 Linear Grill Alignment 1 1 0% PKR60,000.00 30-Jan-18  30-Jan-18 0 PKRO0.00
‘ @ A1380 Nespak Inspection and Approval 0 0 0% PKR0.00 30-Jan-18 39 PKRO.OO|
‘ & A1390 Staging Room - FCU : 0 0 0% PKR0.00 16-Jan-18* 61 PKRO0.00
‘ @ A1400 Ceiling Cutting / Dismantling & Installation of FCU 3 3 0% PKR7,300,000.00 16-Jan-18 | 18-Jan-18 17 PKRO0.00
‘ @ A1430 Installation of Valves and MS Pipe Connections 2 2 0% PKR100,000.00 19-Jan-18 | 22-Jan-18 17 PKRO0.00
‘ @ A1440 Electrical Termination 1 1 0% PKR500,000.00 23-Jan-18  23-Jan-18 17 PKR0.00
‘ @ A1450 Insulation of Duct and Pipes 1 1 0% PKR900,000.00 24-Jan-18  24-Jan-18 17 PKRO.OO|
‘ @ A1460 Ceiling / Ceiling Repairing 1 1 0% PKR100,000.00 | 25-Jan-18 | 25-Jan-18 17 PKRO0.00
‘ & A1470 Installation of Lights 1 1 0% PKR500,000.00 | 26-Jan-18 | 26-Jan-18 17 PKRO0.00
‘ @ A1480 Installation of Smoke Detector / Sprinkler 1 1 0% PKR500,000.00 29-Jan-18 | 29-Jan-18 17 PKRO0.00
‘ & A1490 Linear Grill Alignment 1 1 0% PKR100,000.00  30-Jan-18 | 30-Jan-18 17 PKRO0.00
‘ & A1500 Nespak Inspection and Approval 0 0 0% PKR0.00 30-Jan-18 39 PKRO.OO|
‘ @ A1510 LT Room- FCU : 0 0 0% PKR0.00 31-Jan-18* 61 PKRO0.00
‘ @ A1520 Hanging arrangement and Unit Placement 3 3 0% PKR7,260,000.00 31-Jan-18 | 02-Feb-18 0 PKRO0.00
‘ @ A1530 Fabrication and Installation of Duct Work 1 1 0% PKR60,000.00 05-Feb-18 05-Feb-18 0 PKR0.00
‘ @ A1540 Installation of Valves and MS Pipe Connections 2 2 0% PKR60,000.00 06-Feb-18 07-Feb-18 0 PKRO0.00
‘ @ A1550 Electrical Termination 1 1 0% PKR460,000.00 08-Feb-18 | 08-Feb-18 0 PKRO.OO|
‘ @ A1560 Insulation of Duct and Pipes 1 1 0% PKR860,000.00 09-Feb-18 | 09-Feb-18 0 PKRO0.00
‘ @ A1570 Nespak Inspection and Approval 0 0 0% PKRO0.00 09-Feb-18 31 PKR0.00
‘ @ A1580 Roof Top TFUs : (5 Nos) 0 0 0% PKR0.00 31-Jan-18* 61 PKRO0.00
‘ @ A1600 Shifting and Placement of Units on Foundations al 1 1 0% PKR14,100,000.00 31-Jan-18 | 31-Jan-18 17 PKRO0.00
‘ @ A1610 Duct Work 2 2 0% PKR100,000.00 01-Feb-18 | 02-Feb-18 31 PKRO.OO|
‘ & A1620 Copper Piping 1 1 0% PKR100,000.00 05-Feb-18 | 05-Feb-18 31 PKRO0.00
‘ & A1630 Installation of Cable Trays 1 1 0% PKR500,000.00 06-Feb-18  06-Feb-18 31 PKR0.00
‘ @ A1640 Laying and Ter mination of Power Cables 1 1 0% PKR500,000.00 07-Feb-18 | 07-Feb-18 31 PKRO0.00
‘ @ A1660 Insulation of Duct work and Pipes 2 2 0% PKR900,000.00 08-Feb-18 | 09-Feb-18 31 PKRO0.00
‘ @ A1670 Nespak Inspection and Approval 0 0 0% PKR0.00 09-Feb-18 31 PKRO.OO|
‘ & A1680 AHU - 01 (Basement) 0 0 0% PKR0.00 12-Feb-18* 61 PKRO0.00
‘ @ A1700 Shifting of Unit at location 1 1 0% PKR60,060,000.00 12-Feb-18 | 12-Feb-18 0 PKRO0.00
‘ @ A1720 Installation of SA 1 1 0% PKR60,000.00 13-Feb-18 | 13-Feb-18 0 PKRO0.00
‘ @ A1730 Assembly of AHU Sections 1 1 0% PKR60,000.00 14-Feb-18 | 14-Feb-18 0 PKRO0.00
‘ @ A1740 Fabrication and Installation of MS Pipe and Valves 1 1 0% PKR60,000.00 15-Feb-18 @ 15-Feb-18 0 PKRO.OO|
‘ @ A1750 Installation of Cable Trays 1 1 0% PKR460,000.00 16-Feb-18 | 16-Feb-18 0 PKRO0.00
‘ @ A1760 Laying and Termination of Power Cables 1 1 0% PKR460,000.00 19-Feb-18 | 19-Feb-18 0 PKR0.00
‘ @ A1770 Installation of VCD & FD in Supply & Return Ducts 1 1 0% PKR60,000.00 20-Feb-18 | 20-Feb-18 0 PKRO0.00
s Actual Level of Effort I Actual Work I Critical Remaining Work Page 1 0of 8 TASK filter: All Activities

[ Primary Baseline

[ Remaining Work 4

@ Milestone
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Installation of Valves and MS Pipe Connections
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PPIC3 Final | Classic Schedule Layout | 01-Jan-18 13:06
Dec 31 Jan 07 Jan 14 Jan 21 Jan 28 Feb 04 Feb 11 Feb 18 Feb 25
i l Sat | Sun [Mon | Tue |Wed| Thr | Fri [ Sat | Sun |Mon| Tue (Wed| Thr | Fri [ Sat | Sun|Mon | Tue (Wed| Thr | Fri | Sat [ Sun [Mon| Tue |Wed| Thr | Fri | Sat [ Sun [Mon | Tue |Wed| Thr | Fri | Sat | Sun |Mon | Tue |Wed| Thr | Fri | Sat | Sun |Mon | Tue (Wed| Thr | Fri | Sat [ Sun |Mon | Tue |Wed| Thr | Fri | Sat [ Sun [Mon| Tue |Wed| Thr |Fri
# Training Room 1 - FCU ;, 01-Jan-18
Ceiling Cutting / Dismantling & Installation of FCU :

Insulation of Duct and Pipes

Ceiling / Ceiling Repairing
Installation of Lights

Installation of Smoke Detector / Sprinkler

Linear Grill Alignment

Nespak Inspection and Approval,
4 Training Room 2 - FCU :, 01-Jan-18

Ceiling Cutting / Dismantling & Installation of FCU
Installation of Valves and MS Pipe Connections

7777777777777777777777777777777777777777777 Electrical Temmination

Insulation of Duct and Pipes
Ceiling / Ceiling Repairing
Installation of Lights

Installation of Sm

ke Detector / Sprinkler

Linear Grill Aignment

Nespak Inspection and Approval,
4 Dining Area - FCU :, 16-Jan-18*

..:—ieiling Cutting / Dismantling & Installation of FCU
=_Istallation of Valves and MS pipe Connections

Electrical Termination

Insulation of Duct and Pipes

Ceiling / Ceiling Repairing
Installation of Lights

Installation of Smoke Detector / Sprinkler

777777777777777777777777777777777777777777777777777777777777777777777777777777777777 Linear Grill Alignment
4 Staging Room - FCU :, 16-Jan-18*

Ceiling Cutting / Dismantling & Installation of FCU

Installation of Valves and MS Pipe Connections
77777777777777777777777777777777777777777777777777777777777777777777777777777777777777777777777777777777777777777777777777777777777 Electrical Termination

Insulation of Duct and Pipes :
Ceiling / Ceiling Repairing
Installation of Lights

ation of Smoke Detector / Sprinkler
Linear Grill Alignment
y Nespak Inspection and Approval,

@ LT Room- FCU ;, 31-Jan-18*

Hanging arrangement and Unit Placement

Fabrication and Installation of Duct Work

Installation of Valves and MS Pipe Connections

u_"Electrical Termination
a Insulation of Duct and Pipes

pection and Approval,

& Roof Top TFUs : (5 Nos), 31-Jan-18*

""""""" Ductwork

Copper Piping

Installation of Cable Trays

Laying and Termination pf Power Cables

Nespak Inspection and Approval,

e Insulation of Duct work and Pipes

& AHU - 01 (Basement), 12-Feb-18*

—ﬂ_'jhifting of Unit at location
: ﬂ_&stallation of SA

| Assembly of AU Sections e

Fabrication and Installation of MS Pipe and Valves
Installation of Cable Trays

= Actual Level of Effort
[ Primary Baseline

I Actual Work I Critical Remaining Work
[ Remaining Work 4

Laying and Termination of Power Cables :
H Installation of VCD & FD in Supply & Return Ducts
Page 2 of 8 TASK filter: All Activities
& Milestone
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= Actual Level of Effort I Actual Work I Critical Remaining Work Page 4 of 8 TASK filter: All Activities
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PPIC3 Final Classic Schedule Layout
Activity ID Activity Name Original| Remaining| Schedule % | Budgeted Total Cosi| Start Finish Total| Actual Labor Dec 03 Dec 10 Dec 17 Dec 24
DwiEden|| - DUEiE|  CeipEe P CostIEri T sat | Sun [Mon | Tue [Wed] Thr | Fri | Sat | Sun | Mon| Tue [Wed] Thr | Fri | Sat | Sun | Mon | Tue [Wed] Thr | Fri | Sat | Sun [Mon] Tue [Wed] Thr [Fri
‘ @ A1780 Installation of Humidifier 1 1 0% PKR60,000.00 21-Feb-18 | 21-Feb-18 0 PKRO0.00
‘ & A1790 Fabrication and Installation of Duct Work 1 1 0% PKR60,000.00 22-Feb-18 @ 22-Feb-18 0 PKRO.OO|
‘ @ A1810 Insulation of Duct work and Pipes 1 1 0% PKR860,000.00 23-Feb-18 | 23-Feb-18 0 PKRO0.00
‘ @ A1820 Nespak Inspection and Approval 0 0 0% PKRO0.00 23-Feb-18 21 PKRO0.00
‘ @ A1830 AHU - 03 & 04 (Ground Floor) 0 0 0% PKR0.00 01-Feb-18* 61 PKRO0.00
‘ @ A1860 Shifting of Unit at location 1 1 0% PKR60,100,000.00 01-Feb-18 | 01-Feb-18 17 PKRO0.00
‘ & A1880 Installation of SA 1 1 0% PKR100,000.00 02-Feb-18 | 02-Feb-18 17 PKRO.OO|
‘ @ A1890 Shifting & Placement of Units on Location 1 1 0% PKR100,000.00 05-Feb-18 | 05-Feb-18 17 PKRO0.00
‘ @ A1900 Assembly of AHU Sections 1 1 0% PKR100,000.00 06-Feb-18 | 06-Feb-18 17 PKRO0.00
‘ @ A1910 Fabrication and Installation of MS Pipe and Valves 1 1 0% PKR100,000.00 07-Feb-18 @ 07-Feb-18 17 PKRO0.00
‘ & A1920 Installation of Cable Trays 1 1 0% PKR500,000.00 08-Feb-18 | 08-Feb-18 17 PKRO0.00
‘ & A1930 Laying and Ter mination of Power Cables 1 1 0% PKR500,000.00 09-Feb-18 | 09-Feb-18 17 PKRO.OO|
‘ @ A1940 Installation of VCD & FD in Supply & Return Ducts 1 1 0% PKR100,000.00 12-Feb-18 | 12-Feb-18 17 PKRO0.00
‘ @ A1950 Installation of Humidifier 1 1 0% PKR100,000.00  13-Feb-18 | 13-Feb-18 17 PKRO0.00
‘ @ A1960 Fabrication and Installation of Duct Work 1 1 0% PKR100,000.00 14-Feb-18 | 14-Feb-18 17 PKRO0.00
‘ @ A1980 Insulation of Duct work and Pipes 1 1 0% PKR900,000.00 15-Feb-18 | 15-Feb-18 17 PKRO0.00
‘ @ A1990 Nespak Inspection and Approval 0 0 0% PKRO0.00 15-Feb-18 27 PKRO.OO|
‘ @ A2000 AHU - 06 & 07 (First Floor) 0 0 0% PKR0.00 26-Feb-18* 61 PKRO0.00
‘ @ A2020 Placment of Units at Foundation 1 1 0% PKR60,060,000.00 26-Feb-18 |26-Feb-18 0 PKRO0.00
‘ & A2040 Installation of SA 1 1 0% PKR60,000.00 27-Feb-18 | 27-Feb-18 0 PKRO0.00
‘ & A2050 Assembly of AHU Sections 1 1 0% PKR60,000.00 28-Feb-18 | 28-Feb-18 0 PKRO0.00
‘ & A2060 Fabrication and Installation of MS Pipe and Valves 1 1 0% PKR60,000.00 01-Mar-18  01-Mar-18 0 PKRO.OO|
‘ @ A2070 Installation of Cable Trays 1 1 0% PKR460,000.00 02-Mar-18 | 02-Mar-18 0 PKRO0.00
‘ @ A2080 Laying and Termination of Power Cables 1 1 0% PKR460,000.00 05-Mar-18 @ 05-Mar-18 0 PKRO0.00
‘ @ A2090 Installation of VCD & FD in Supply & Return Ducts 1 1 0% PKR60,000.00 06-Mar-18  06-Mar-18 0 PKRO0.00
‘ @ A2100 Installation of Humidifier 1 1 0% PKR60,000.00 07-Mar-18 | 07-Mar-18 0 PKRO0.00
‘ & A2110 Fabrication and Installation of Duct Work 1 1 0% PKR60,000.00 08-Mar-18  08-Mar-18 0 PKRO.OO|
‘ @ A2130 Insulation of Duct work and Pipes 1 1 0% PKR860,000.00 09-Mar-18 | 09-Mar-18 0 PKRO0.00
‘ @ A2140 Nespak Inspection and Approval 0 0 0% PKRO0.00 09-Mar-18 1 PKRO0.00
‘ @ A2150 AHU - 02 (First Floor) 0 0 0% PKR0.00 16-Feb-18* 61 PKRO0.00
‘ @ A2170 Shifting & Placement of Units on Location 1 1 0% PKR60,100,000.00 16-Feb-18 | 16-Feb-18 17 PKRO0.00
‘ @ A2190 Installation of SA 1 1 0% PKR100,000.00 19-Feb-18 | 19-Feb-18 17 PKRO.OO|
‘ @ A2200 Assembly of AHU Sections 1 1 0% PKR100,000.00  20-Feb-18 | 20-Feb-18 17 PKRO0.00
‘ w A2210 Fabrication and Installation of MS Pipe and Valves 1 1 0% PKR100,000.00 21-Feb-18 | 21-Feb-18 17 PKR0.00
‘ @ A2220 Installation of Cable Trays 1 1 0% PKR500,000.00 | 22-Feb-18 | 22-Feb-18 17 PKRO0.00
‘ @ A2230 Laying and Ter mination of Power Cables 1 1 0% PKR500,000.00 | 23-Feb-18 | 23-Feb-18 17 PKRO0.00
‘ @ A2240 Installation of VCD & FD in Supply & Return Ducts 1 1 0% PKR100,000.00  26-Feb-18 | 26-Feb-18 17 PKRO.OO|
‘ @ A2250 Installation of Humidifier 1 1 0% PKR100,000.00 27-Feb-18 | 27-Feb-18 17 PKR0.00
‘ @ A2260 Fabrication and Installation of Duct Work 1 1 0% PKR100,000.00 28-Feb-18 | 28-Feb-18 17 PKR0.00
‘ w A2280 Insulation of Duct work and Pipes 1 1 0% PKR900,000.00 01-Mar-18 | 01-Mar-18 17 PKR0.00
‘ @ A2290 Nespak Inspection and Approval 0 0 0% PKRO0.00 01-Mar-18 17 PKRO0.00
‘ @ A2300 AHU - 05 (Ground Floor) 0 0 0% PKR0.00 12-Mar-18* 61 PKRO.OO|
‘ @ A2320 Wall Dismantling 1 1 0% PKR60,000.00 12-Mar-18 | 12-Mar-18 0 PKRO0.00
‘ & A2330 Shifting & Placement of Units on Location 1 1 0% PKR60,060,000.00 13-Mar-18 @ 13-Mar-18 0 PKR0.00
‘ @ A2350 Installation of SA 1 1 0% PKR60,000.00 14-Mar-18 | 14-Mar-18 0 PKRO0.00
‘ @ A2360 Assembly of AHU Sections 1 1 0% PKR60,000.00 15-Mar-18 | 15-Mar-18 0 PKRO0.00
‘ @ A2370 Fabrication and Installation of MS Pipe and Valves 1 1 0% PKR60,000.00 16-Mar-18  16-Mar-18 0 PKRO.OO|
‘ @ A2380 Installation of Cable Trays 1 1 0% PKR460,000.00  19-Mar-18 | 19-Mar-18 0 PKRO0.00
‘ & A2390 Laying and Termination of Power Cables 1 1 0% PKR460,000.00  20-Mar-18 | 20-Mar-18 0 PKRO0.00
‘ @ A2400 Installation of VCD & FD in Supply & Return Ducts 1 1 0% PKR60,000.00 21-Mar-18  21-Mar-18 0 PKRO0.00
‘ @ A2410 Installation of Humidifier 1 1 0% PKR60,000.00 22-Mar-18 | 22-Mar-18 0 PKRO0.00
‘ @ A2420 Fabrication and Installation of Duct Work 1 1 0% PKR60,000.00 23-Mar-18  23-Mar-18 0 PKRO.OO|
‘ w A2440 Insulation of Duct work and Pipes 1 1 0% PKR860,000.00 26-Mar-18 | 26-Mar-18 0 PKR0.00
‘ @ A2450 Nespak Inspection and Approval 0 0 0% PKRO0.00 26-Mar-18 0 PKRO0.00
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[ Primary Baseline

[ Remaining Work 4

@ Milestone

© Oracle Corporation




PPIC3 Final

Jan 14

Classic Schedule Layout |

01-Jan-18 13:06

Dec 31

Jan 07

Jan 21

Jan 28

Feb 04 Feb 11

Feb 18 Feb 25

Mon | Tue [Wed | Thr | Fri | Sat

Sun |Mon| Tue |Wed| Thr | Fri | Sat

Sun |Mon | Tue [Wed | Thr | Fri | Sat

Sun [Mon | Tue |Wed| Thr | Fri | Sat

Sun |Mon | Tue [Wed | Thr | Fri | Sat

Sun [Mon| Tue |Wed| Thr | Fri | Sat

Sun [Mon | Tue [Wed | Thr | Fri | Sat | Sun [Mon| Tue |Wed| Thr |Fri

Sun |Mon| Tue |Wed| Thr | Fri | sat

: pection and Approval,
. @ AHU - 03 & 04 (Ground Floor), 01-Feb-18* f
»H shiingof Unitatlocation I
Installation of SA
Shifting & Placement of Units on Location
Assembly of AHU Sections
Fabrication and Installation of MS Pipe and Valves :
,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, Installation of Gable Trays .|
Laying and Termination of Power Cables
Installation of VCD & FD in Supply & Return Ducts
Installation of Humidifier
Fabrication and Installation of Duct Work :
,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, Insulation of Duct work and Pipes
Nespak Inspection and Approval, :
@ AHU - 06 & 07 (First Flo
L./ Placment ofiUnits atFi
Installation of SA
,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, _ Assembly
Fab
-8
& AHU - 02 (First Floor), 16-Feb-18*
R = I Shiting & Placement of Units on Location .
: Installation of SA :
Assembly of AHU Sections :
Fabrication and Installation of MS Pipe andiVaIves
Installation of Cable Trays :
: Installation of VCD & F
Installfation of Hy
iFabricatior
: Insu
Nes

Installation of Humidifier :

Insulation of Duct work and Pipes

= Actual Level of Effort
[ Primary Baseline

I Actual Work I Critical Remaining Work
[ Remaining Work 4 @ Milestone

Page 6 of 8

TASK filter: All Activities

© Oracle Corporation




PPIC3 Final

| Classic Schedule Layout | 01-Jan-18 13:06

Mar 04 Mar 11 Mar 18 Mar 25 Apr 01 Apr 08 Apr 15 Apr 22 Apr 29
| sat | Sun |Mon | Tue [Wed| Thr | Fri | Sat |Sun [Mon | Tue [Wed]| Thr | Fri | Sat | Sun [Mon| Tue |Wed| Thr | Fri | Sat | Sun [Mon | Tue [Wed| Thr | Fri | Sat [ Sun [Mon| Tue |Wed| Thr | Fri | Sat | Sun |Mon | Tue [Wed| Thr | Fri | Sat | Sun [Mon| Tue |Wed| Thr | Fri | Sat | Sun [Mon | Tue [Wed| Thr | Fri | Sat | Sun [Mon| Tue |Wed| Thr | Fri
r), 26-Feb-18*
undation

whliseetions S

ication and Installation of MS Pipe and Valves
Installation of Cable Trays

D in Supply & Return Ducts
nidifier
and Installation of Duct Work

jation of Duct work and Pipes
ak Inspection and Approval,

Laying and Ter mination of Power Cables
Installation of VCD & FD in Supply & Return Ducts
Installation of Humidifier

Fabrication and Installation of Duct Work
Insulation of Duct work and Pipes

pection and Approval,

& AHU - 05 (Ground Floor), 12-Mar-18*

Wall Dismantling
Shifting & Placement of Units on Location
Installation of SA
Assembly Of AHU SeClonS ]
Fabrication and Installation of MS Pipe and Valves
Installation of Cable Trays
ujiaying and Termination of Power Cables
Installation of VCD & FD in Supply & Return Ducts
Installation of Humidifier

u Fabrication and Installation of Duct Work f
g Insulation of Duct work and Pipes

Nespak Inspection and Approval,

= Actual Level of Effort
[ Primary Baseline

I Actual Work
[ Remaining Work 4

I Critical Remaining Work
& Milestone

Page 7 of 8 TASK filter: All Activities

© Oracle Corporation




PPIC3 Final | Classic Schedule Layout | 01-Jan-18 13:06

May 06 May 13 May 20 May 27 Jun 03 Jun 10 Jun 17 Jun 24 Jul 01

Sat | Sun |Mon | Tue [Wed | Thr | Fri | Sat | Sun [Mon | Tue |Wed| Thr | Fri | Sat [ Sun [Mon| Tue |Wed| Thr | Fri | Sat | Sun [ Mon | Tue [Wed| Thr | Fri | Sat [ Sun [Mon| Tue |Wed| Thr | Fri | Sat | Sun [Mon | Tue [Wed | Thr | Fri | Sat | Sun [Mon| Tue |Wed| Thr | Fri | Sat | Sun |Mon | Tue [Wed | Thr | Fri | Sat | Sun [Mon| Tue [Wed| Thr | Fri

= Actual Level of Effort I Actual Work I Critical Remaining Work Page 8 of 8 TASK filter: All Activities
[ Primary Baseline [ Remaining Work 4 @ Milestone © Oracle Corporation




.

L PRIMAVERA CBT
N

cs

P A K I T A

Version: 0

Project Reports

b

pPIC3 LAHORE
=

MECSOL

P A KISTAN

V2 Huawel

Project Name: PPIC3, Lahore
Project Manager: Mr. Syed Aijaz

Mr. Syed Aijaz
Project Manager
Mr. Fahad Arif

Planning & Coordination Engineer

Al|Page



PPIC3 Final Project Start 01-Jan-18
Report Date 04-Jan-18 14:28 Project Finish 26-Mar-18

LG-02 Logic Report, Critical Path, By Project

User's Notes:

Activity ID Activity Name Early Start Early Finish Late Start Late Finish Total Float Predecessors Successors

PPIC3 Final

A1080 Ceiling Cutting / Dismantling & 01-Jan-18 03-Jan-18 01-Jan-18 03-Jan-18 0 A1090,A1180
Installation of FCU

A1090 Installation of Valves and MS Pipe 04-Jan-18 05-Jan-18 04-Jan-18 05-Jan-18 0 A1080 A1100
Connections

A1100 Electrical Termination 08-Jan-18 08-Jan-18 08-Jan-18 08-Jan-18 0 A1090 A1110

A1110 Insulation of Duct and Pipes 09-Jan-18 09-Jan-18 09-Jan-18 09-Jan-18 0 A1100 A1120

A1120 Ceiling / Ceiling Repairing 10-Jan-18 10-Jan-18 10-Jan-18 10-Jan-18 0 A1110 A1130

A1130 Installation of Lights 11-Jan-18 11-Jan-18 11-Jan-18 11-Jan-18 0 A1120 A1140

A1140 Installation of Smoke Detector / 12-Jan-18 12-Jan-18 12-Jan-18 12-Jan-18 0 A1130 A1150
Sprinkler

A1150 Linear Grill Alignment 15-Jan-18 15-Jan-18 15-Jan-18 15-Jan-18 0 A1140 A1160, A1300

A1300 Ceiling Cutting / Dismantling & 16-Jan-18 18-Jan-18 16-Jan-18 18-Jan-18 0 A1150 A1310
Installation of FCU

A1310 Installation of Valves and MS pipe 19-Jan-18 22-Jan-18 19-Jan-18 22-Jan-18 0 A1300 A1320
Connections

A1320 Electrical Termination 23-Jan-18 23-Jan-18 23-Jan-18 23-Jan-18 0 A1310 A1330

A1330 Insulation of Duct and Pipes 24-Jan-18 24-Jan-18 24-Jan-18 24-Jan-18 0 A1320 A1340

A1340 Ceiling / Ceiling Repairing 25-Jan-18 25-Jan-18 25-Jan-18 25-Jan-18 0 A1330 A1350

A1350 Installation of Lights 26-Jan-18 26-Jan-18 26-Jan-18 26-Jan-18 0 A1340 A1360

A1360 Installation of Smoke Detector / 29-Jan-18 29-Jan-18 29-Jan-18 29-Jan-18 0 A1350 A1370
Sprinkler

A1370 Linear Grill Alignment 30-Jan-18 30-Jan-18 30-Jan-18 30-Jan-18 0 A1360 A1380,A1520

A1520 Hanging arrangement and Unit 31-Jan-18 02-Feb-18 31-Jan-18 02-Feb-18 0 A1370 A1530
Placement

A1530 Fabrication and Installation of Duct 05-Feb-18 05-Feb-18 05-Feb-18 05-Feb-18 0 A1520 A1540
Work

# Oracle Primavera
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PPIC3 Final Project Start 01-Jan-18
Report Date 04-Jan-18 14:28 Project Finish 26-Mar-18

LG-02 Logic Report, Critical Path, By Project

User's Notes:

Activity ID Activity Name Early Start Early Finish Late Start Late Finish Total Float Predecessors Successors
A1540 Installation of Valves and MS Pipe 06-Feb-18 07-Feb-18 06-Feb-18 07-Feb-18 0 A1530 A1550
Connections
A1550 Electrical Termination 08-Feb-18 08-Feb-18 08-Feb-18 08-Feb-18 0 A1540 A1560
A1560 Insulation of Duct and Pipes 09-Feb-18 09-Feb-18 09-Feb-18 09-Feb-18 0 A1550 A1570,A1700
A1700 Shifting of Unit at location 12-Feb-18 12-Feb-18 12-Feb-18 12-Feb-18 0 A1560 A1720
A1720 Installation of SA 13-Feb-18 13-Feb-18 13-Feb-18 13-Feb-18 0 A1700 A1730
A1730 Assembly of AHU Sections 14-Feb-18 14-Feb-18 14-Feb-18 14-Feb-18 0 A1720 A1740
A1740 Fabrication and Installation of MS 15-Feb-18 15-Feb-18 15-Feb-18 15-Feb-18 0 A1730 A1750
Pipe and Valves
A1750 Installation of Cable Trays 16-Feb-18 16-Feb-18 16-Feb-18 16-Feb-18 0 A1740 A1760
A1760 Laying and Termination of Power 19-Feb-18 19-Feb-18 19-Feb-18 19-Feb-18 0 A1750 A1770
Cables
A1770 Installation of VCD & FD in Supply &  20-Feb-18 20-Feb-18 20-Feb-18 20-Feb-18 0 A1760 A1780
Return Ducts
A1780 Installation of Humidifier 21-Feb-18 21-Feb-18 21-Feb-18 21-Feb-18 0 A1770 A1790
A1790 \I;Vabrli(cation and Installation of Duct 22-Feb-18 22-Feb-18 22-Feb-18 22-Feb-18 0 A1780 A1810
or
A1810 Insulation of Duct work and Pipes 23-Feb-18 23-Feb-18 23-Feb-18 23-Feb-18 0 A1790 A1820, A2020
A2020 Placment of Units at Foundation 26-Feb-18 26-Feb-18 26-Feb-18 26-Feb-18 0 A1810 A2040
A2040 Installation of SA 27-Feb-18 27-Feb-18 27-Feb-18 27-Feb-18 0 A2020 A2050
A2050 Assembly of AHU Sections 28-Feb-18 28-Feb-18 28-Feb-18 28-Feb-18 0 A2040 A2060
A2060 Fabrication and Installation of MS 01-Mar-18 01-Mar-18 01-Mar-18 01-Mar-18 0 A2050 A2070
Pipe and Valves
A2070 Installation of Cable Trays 02-Mar-18 02-Mar-18 02-Mar-18 02-Mar-18 0 A2060 A2080
A2080 I(_:a}g?g and Termination of Power 05-Mar-18 05-Mar-18 05-Mar-18 05-Mar-18 0 A2070 A2090
ables
A2090 Installation of VCD & FD in Supply &  06-Mar-18 06-Mar-18 06-Mar-18 06-Mar-18 0 A2080 A2100
Return Ducts
A2100 Installation of Humidifier 07-Mar-18 07-Mar-18 07-Mar-18 07-Mar-18 0 A2090 A2110

# Oracle Primavera
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PPIC3 Final Project Start 01-Jan-18
Report Date 04-Jan-18 14:28 Project Finish 26-Mar-18

LG-02 Logic Report, Critical Path, By Project

User's Notes:

Activity ID Activity Name Early Start Early Finish Late Start Late Finish Total Float Predecessors Successors
A2110 \I;Vabrli(cation and Installation of Duct 08-Mar-18 08-Mar-18 08-Mar-18 08-Mar-18 0 A2100 A2130
or
A2130 Insulation of Duct work and Pipes 09-Mar-18 09-Mar-18 09-Mar-18 09-Mar-18 0 A2110 A2140, A2320
A2320 Wall Dismantling 12-Mar-18 12-Mar-18 12-Mar-18 12-Mar-18 0 A2130 A2330
A2330 Shifting & Placement of Units on 13-Mar-18 13-Mar-18 13-Mar-18 13-Mar-18 0 A2320 A2350
Location
A2350 Installation of SA 14-Mar-18 14-Mar-18 14-Mar-18 14-Mar-18 0 A2330 A2360
A2360 Assembly of AHU Sections 15-Mar-18 15-Mar-18 15-Mar-18 15-Mar-18 0 A2350 A2370
A2370 Fabrication and Installation of MS 16-Mar-18 16-Mar-18 16-Mar-18 16-Mar-18 0 A2360 A2380
Pipe and Valves
A2380 Installation of Cable Trays 19-Mar-18 19-Mar-18 19-Mar-18 19-Mar-18 0 A2370 A2390
A2390 Iéa%?g and Termination of Power 20-Mar-18 20-Mar-18 20-Mar-18 20-Mar-18 0 A2380 A2400
ables
A2400 Installation of VCD & FD in Supply &  21-Mar-18 21-Mar-18 21-Mar-18 21-Mar-18 0 A2390 A2410
Return Ducts
A2410 Installation of Humidifier 22-Mar-18 22-Mar-18 22-Mar-18 22-Mar-18 0 A2400 A2420
A2420 \I;\;abrli(cation and Installation of Duct 23-Mar-18 23-Mar-18 23-Mar-18 23-Mar-18 0 A2410 A2440
or
A2440 Insulation of Duct work and Pipes 26-Mar-18 26-Mar-18 26-Mar-18 26-Mar-18 0 A2420 A2450
A2450 Nespak Inspection and Approval 26-Mar-18 26-Mar-18 0 A2440

# Oracle Primavera
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PPIC3 Final

Report Date 01-Jan-18 16:40

User's Notes:

Project Start 01-Jan-18
Project Finish 26-Mar-18

PW-04 WBS Assigned Resources

WBS Code

Resource Code

Resource Name

PPIC3
01
NEWPROJ-4

# Oracle Primavera

PPIC3.PPIC3 1
PPIC3.PPIC3 3
PPIC3.PPIC3 2
PPIC3.PPIC3 4
PPIC3.PPIC3 5
PPIC3.PPIC3 6
PPIC3.PPIC3 7
PPIC3.PPIC3 8
PPIC3.PPIC3 9

Page 1 of 1

FCU

TFU

AHU

Execution Team 1

Execution Team 2

Electrical Items

Duct & Pipe Insulation Material
Project Engineer

Project Manager



PPIC3 Final
Report Date 01-Jan-18 17:41

Project Start 01-Jan-18
Project Finish 26-Mar-18

RA-01 Resource Assignments, All Activities
User's Notes:

Resource Resource Name

Code

Project Code WBS Code Activity Code Activity Planned Units Planned Planned StartPlanned Finish

Duration

PPIC3 1 FCU

NEWPROJ-4 NEWPROJ-4 A1080 Ceiling Cutting / Dismantling & 40 3 01-Jan-18 03-Jan-18
Installation of FCU

NEWPROJ-4 NEWPROJ-4 A1180 Ceiling Cutting / Dismantling & 40 3 01-Jan-18 03-Jan-18
Installation of FCU

NEWPROJ-4 NEWPROJ-4 A1300 Ceiling Cutting / Dismantling & 40 3 16-Jan-18 18-Jan-18
Installation of FCU

NEWPROJ-4 NEWPROJ-4 A1400 Ceiling Cutting / Dismantling & 40 3 16-Jan-18 18-Jan-18
Installation of FCU

NEWPROJ-4 NEWPROJ-4  A1520 Hanging arrangement and Unit 40 3 31-Jan-18 02-Feb-18
Placement

Total 200

PPIC3 3 TFU

NEWPROJ-4 NEWPROJ-4 A1600 Shifting and Placement of Units on 40 1 31-Jan-18 31-Jan-18
Foundations at Roof

Total 40

PPIC3 2 AHU

NEWPROJ-4 NEWPROJ-4 A1700 Shifting of Unit at location 40 1 12-Feb-18 12-Feb-18

NEWPROJ-4 NEWPROJ-4 A1860 Shifting of Unit at location 40 1 01-Feb-18 01-Feb-18

NEWPROJ-4 NEWPROJ-4 A2020 Placment of Units at Foundation 40 1 26-Feb-18 26-Feb-18

# Oracle Primavera

Page 1 of 15



PPIC3 Final
Report Date 01-Jan-18 17:41

Project Start 01-Jan-18
Project Finish 26-Mar-18

RA-01 Resource Assignments, All Activities
User's Notes:

Resource Resource Name

Code

Project Code WBS Code Activity Code Activity Planned Units Planned Planned StartPlanned Finish

Duration

NEWPROJ-4 NEWPROJ-4 A2170 Shifting & Placement of Units on 40 1 16-Feb-18 16-Feb-18
Location

NEWPROJ-4 NEWPROJ-4  A2330 Shifting & Placement of Units on 40 1 13-Mar-18 13-Mar-18
Location

Total 200

PPIC3 4 Execution Team 1

NEWPROJ-4 NEWPROJ-4 A1080 Ceiling Cutting / Dismantling & 40 3 01-Jan-18 03-Jan-18
Installation of FCU

NEWPROJ-4 NEWPROJ-4 A1090 Installation of Valves and MS Pipe 40 2 04-Jan-18 05-Jan-18
Connections

NEWPROJ-4 NEWPROJ-4 A1100 Electrical Termination 40 1 08-Jan-18 08-Jan-18

NEWPROJ-4 NEWPROJ-4 A1110 Insulation of Duct and Pipes 40 1 09-Jan-18 09-Jan-18

NEWPROJ-4 NEWPROJ-4 A1120 Ceiling / Ceiling Repairing 40 1 10-Jan-18 10-Jan-18

NEWPROJ-4 NEWPROJ-4 A1130 Installation of Lights 40 1 11-Jan-18 11-Jan-18

NEWPROJ-4 NEWPROJ-4 A1140 Installation of Smoke Detector / 40 1 12-Jan-18 12-Jan-18
Sprinkler

NEWPROJ-4 NEWPROJ-4 A1150 Linear Grill Alignment 40 1 15-Jan-18 15-Jan-18

NEWPROJ-4 NEWPROJ-4 A1300 Ceiling Cutting / Dismantling & 40 3 16-Jan-18 18-Jan-18
Installation of FCU

NEWPROJ-4 NEWPROJ-4 A1310 Installation of Valves and MS pipe 40 2 19-Jan-18 22-Jan-18
Connections

NEWPROJ-4 NEWPROJ4 A1320 Electrical Termination 40 1 23-Jan-18 23-Jan-18

NEWPROJ-4 NEWPROJ-4 A1330 Insulation of Duct and Pipes 40 1 24-Jan-18 24-Jan-18

# Oracle Primavera
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PPIC3 Final
Report Date 01-Jan-18 17:41

Project Start 01-Jan-18
Project Finish 26-Mar-18

RA-01 Resource Assignments, All Activities
User's Notes:

Resource Resource Name

Code

Project Code WBS Code Activity Code Activity Planned Units Planned Planned StartPlanned Finish

Duration

NEWPROJ-4 NEWPROJ-4 A1340 Ceiling / Ceiling Repairing 40 1 25-Jan-18 25-Jan-18

NEWPROJ-4 NEWPROJ-4 A1350 Installation of Lights 40 1 26-Jan-18 26-Jan-18

NEWPROJ-4 NEWPROJ-4 A1360 Installation of Smoke Detector / 40 1 29-Jan-18 29-Jan-18
Sprinkler

NEWPROJ-4 NEWPROJ-4 A1370 Linear Grill Alignment 40 1 30-Jan-18 30-Jan-18

NEWPROJ-4 NEWPROJ-4 A1520 Hanging arrangement and Unit 40 3 31-Jan-18 02-Feb-18
Placement

NEWPROJ-4 NEWPROJ4 A1530 Fabrication and Installation of Duct Work 40 1 05-Feb-18 05-Feb-18

NEWPROJ-4 NEWPROJ4 A1540 Installation of Valves and MS Pipe 40 2 06-Feb-18 07-Feb-18
Connections

NEWPROJ-4 NEWPROJ-4 A1550 Electrical Termination 40 1 08-Feb-18 08-Feb-18

NEWPROJ-4 NEWPROJ4 A1560 Insulation of Duct and Pipes 40 1 09-Feb-18 09-Feb-18

NEWPROJ-4 NEWPROJ4 A1700 Shifting of Unit at location 40 1 12-Feb-18 12-Feb-18

NEWPROJ-4 NEWPROJ-4 A1720 Installation of SA 40 1 13-Feb-18 13-Feb-18

NEWPROJ-4 NEWPROJ-4 A1730 Assembly of AHU Sections 40 1 14-Feb-18 14-Feb-18

NEWPROJ-4 NEWPROJ-4 A1740 Fabrication and Installation of MS Pipe 40 1 15-Feb-18 15-Feb-18
and Valves

NEWPROJ-4 NEWPROJ-4 A1750 Installation of Cable Trays 40 1 16-Feb-18 16-Feb-18

NEWPROJ-4 NEWPROJ-4 A1760 Laying and Termination of Power Cables 40 1 19-Feb-18 19-Feb-18

NEWPROJ-4 NEWPROJ-4 A1770 Installation of VCD & FD in Supply & 40 1 20-Feb-18 20-Feb-18
Return Ducts

NEWPROJ-4 NEWPROJ-4 A1780 Installation of Humidifier 40 1 21-Feb-18 21-Feb-18

NEWPROJ-4 NEWPROJ-4 A1790 Fabrication and Installation of Duct Work 40 1 22-Feb-18 22-Feb-18

NEWPROJ-4 NEWPROJ-4 A1810 Insulation of Duct work and Pipes 40 1 23-Feb-18 23-Feb-18
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PPIC3 Final
Report Date 01-Jan-18 17:41

Project Start 01-Jan-18
Project Finish 26-Mar-18

RA-01 Resource Assignments, All Activities
User's Notes:

Resource Resource Name

Code

Project Code WBS Code Activity Code Activity Planned Units Planned Planned StartPlanned Finish

Duration

NEWPROJ-4 NEWPROJ-4 A2020 Placment of Units at Foundation 40 1 26-Feb-18 26-Feb-18

NEWPROJ-4 NEWPROJ-4  A2040 Installation of SA 40 1 27-Feb-18 27-Feb-18

NEWPROJ-4 NEWPROJ-4  A2050 Assembly of AHU Sections 40 1 28-Feb-18 28-Feb-18

NEWPROJ-4 NEWPROJ-4 A2060 Fabrication and Installation of MS Pipe 40 1 01-Mar-18 01-Mar-18
and Valves

NEWPROJ-4 NEWPROJ-4 A2070 Installation of Cable Trays 40 1 02-Mar-18 02-Mar-18

NEWPROJ-4 NEWPROJ-4  A2080 Laying and Termination of Power Cables 40 1 05-Mar-18 05-Mar-18

NEWPROJ-4 NEWPROJ-4  A2090 Installation of VCD & FD in Supply & 40 1 06-Mar-18 06-Mar-18
Return Ducts

NEWPROJ-4 NEWPROJ4 A2100 Installation of Humidifier 40 1 07-Mar-18 07-Mar-18

NEWPROJ-4 NEWPROJ-4 A2110 Fabrication and Installation of Duct Work 40 1 08-Mar-18 08-Mar-18

NEWPROJ-4 NEWPROJ4 A2130 Insulation of Duct work and Pipes 40 1 09-Mar-18 09-Mar-18

NEWPROJ-4 NEWPROJ4  A2320 Wall Dismantling 40 1 12-Mar-18 12-Mar-18

NEWPROJ-4 NEWPROJ-4 A2330 Shifting & Placement of Units on 40 1 13-Mar-18 13-Mar-18
Location

NEWPROJ-4 NEWPROJ-4  A2350 Installation of SA 40 1 14-Mar-18 14-Mar-18

NEWPROJ-4 NEWPROJ-4 A2360 Assembly of AHU Sections 40 1 15-Mar-18 15-Mar-18

NEWPROJ-4 NEWPROJ-4 A2370 Fabrication and Installation of MS Pipe 40 1 16-Mar-18 16-Mar-18
and Valves

NEWPROJ-4 NEWPROJ-4 A2380 Installation of Cable Trays 40 1 19-Mar-18 19-Mar-18

NEWPROJ-4 NEWPROJ-4 A2390 Laying and Termination of Power Cables 40 1 20-Mar-18 20-Mar-18

NEWPROJ-4 NEWPROJ-4  A2400 Installation of VCD & FD in Supply & 40 1 21-Mar-18 21-Mar-18
Return Ducts

NEWPROJ-4 NEWPROJ-4 A2410 Installation of Humidifier 40 1 22-Mar-18 22-Mar-18

# Oracle Primavera

Page 4 of 15



PPIC3 Final
Report Date 01-Jan-18 17:41

Project Start 01-Jan-18
Project Finish 26-Mar-18

RA-01 Resource Assignments, All Activities
User's Notes:

Resource Resource Name

Code

Project Code WBS Code Activity Code Activity Planned Units Planned Planned StartPlanned Finish

Duration
NEWPROJ-4 NEWPROJ4 A2420 Fabrication and Installation of Duct Work 40 1 23-Mar-18 23-Mar-18
NEWPROJ-4 NEWPROJ-4 A2440 Insulation of Duct work and Pipes 40 1 26-Mar-18 26-Mar-18
Total 2080

PPIC3 5 Execution Team 2

NEWPROJ-4 NEWPROJ4 A1180 Ceiling Cutting / Dismantling & 40 3 01-Jan-18 03-Jan-18
Installation of FCU

NEWPROJ-4 NEWPROJ-4 A1210 Installation of Valves and MS Pipe 40 2 04-Jan-18 05-Jan-18
Connections

NEWPROJ-4 NEWPROJ4 A1220 Electrical Termination 40 1 08-Jan-18 08-Jan-18

NEWPROJ-4 NEWPROJ4 A1230 Insulation of Duct and Pipes 40 1 09-Jan-18 09-Jan-18

NEWPROJ-4 NEWPROJ-4 A1240 Ceiling / Ceiling Repairing 40 1 10-Jan-18 10-Jan-18

NEWPROJ-4 NEWPROJ-4 A1250 Installation of Lights 40 1 11-Jan-18 11-Jan-18

NEWPROJ-4 NEWPROJ-4  A1260 Installation of Smoke Detector / 40 1 12-Jan-18 12-Jan-18
Sprinkler

NEWPROJ-4 NEWPROJ-4 A1270 Linear Grill Alignment 40 1 15-Jan-18 15-Jan-18

NEWPROJ-4 NEWPROJ-4 A1400 Ceiling Cutting / Dismantling & 40 3 16-Jan-18 18-Jan-18
Installation of FCU

NEWPROJ-4 NEWPROJ-4 A1430 Installation of Valves and MS Pipe 40 2 19-Jan-18 22-Jan-18
Connections

NEWPROJ-4 NEWPROJ-4 A1440 Electrical Termination 40 1 23-Jan-18 23-Jan-18

NEWPROJ-4 NEWPROJ-4 A1450 Insulation of Duct and Pipes 40 1 24-Jan-18 24-Jan-18

NEWPROJ-4 NEWPROJ-4 A1460 Ceiling / Ceiling Repairing 40 1 25-Jan-18 25-Jan-18
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PPIC3 Final
Report Date 01-Jan-18 17:41

Project Start 01-Jan-18
Project Finish 26-Mar-18

RA-01 Resource Assignments, All Activities
User's Notes:

Resource Resource Name

Code

Project Code WBS Code Activity Code Activity Planned Units Planned Planned StartPlanned Finish

Duration

NEWPROJ-4 NEWPROJ-4 A1470 Installation of Lights 40 1 26-Jan-18 26-Jan-18

NEWPROJ-4 NEWPROJ-4 A1480 Installation of Smoke Detector / 40 1 29-Jan-18 29-Jan-18
Sprinkler

NEWPROJ-4 NEWPROJ4 A1490 Linear Grill Alignment 40 1 30-Jan-18 30-Jan-18

NEWPROJ-4 NEWPROJ-4 A1600 Shifting and Placement of Units on 40 1 31-Jan-18 31-Jan-18
Foundations at Roof

NEWPROJ-4 NEWPROJ4 A1610 Duct Work 40 2 01-Feb-18 02-Feb-18

NEWPROJ-4 NEWPROJ4 A1620 Copper Piping 40 1 05-Feb-18 05-Feb-18

NEWPROJ-4 NEWPROJ4 A1630 Installation of Cable Trays 40 1 06-Feb-18 06-Feb-18

NEWPROJ-4 NEWPROJ-4 A1640 Laying and Termination of Power Cables 40 1 07-Feb-18 07-Feb-18

NEWPROJ-4 NEWPROJ4 A1660 Insulation of Duct work and Pipes 40 2 08-Feb-18 09-Feb-18

NEWPROJ-4 NEWPROJ4 A1860 Shifting of Unit at location 40 1 01-Feb-18 01-Feb-18

NEWPROJ-4 NEWPROJ4 A1880 Installation of SA 40 1 02-Feb-18 02-Feb-18

NEWPROJ-4 NEWPROJ-4 A1890 Shifting & Placement of Units on 40 1 05-Feb-18 05-Feb-18
Location

NEWPROJ-4 NEWPROJ-4  A1900 Assembly of AHU Sections 40 1 06-Feb-18 06-Feb-18

NEWPROJ-4 NEWPROJ-4 A1910 Fabrication and Installation of MS Pipe 40 1 07-Feb-18 07-Feb-18
and Valves

NEWPROJ-4 NEWPROJ-4 A1920 Installation of Cable Trays 40 1 08-Feb-18 08-Feb-18

NEWPROJ-4 NEWPROJ-4 A1930 Laying and Termination of Power Cables 40 1 09-Feb-18 09-Feb-18

NEWPROJ-4 NEWPROJ-4 A1940 Installation of VCD & FD in Supply & 40 1 12-Feb-18 12-Feb-18
Return Ducts

NEWPROJ-4 NEWPROJ-4 A1950 Installation of Humidifier 40 1 13-Feb-18 13-Feb-18

NEWPROJ-4 NEWPROJ-4 A1960 Fabrication and Installation of Duct Work 40 1 14-Feb-18 14-Feb-18
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PPIC3 Final
Report Date 01-Jan-18 17:41

Project Start 01-Jan-18
Project Finish 26-Mar-18

RA-01 Resource Assignments, All Activities
User's Notes:

Resource Resource Name

Code

Project Code WBS Code Activity Code Activity Planned Units Planned Planned StartPlanned Finish

Duration

NEWPROJ-4 NEWPROJ4 A1980 Insulation of Duct work and Pipes 40 1 15-Feb-18 15-Feb-18

NEWPROJ-4 NEWPROJ-4 A2170 Shifting & Placement of Units on 40 1 16-Feb-18 16-Feb-18
Location

NEWPROJ-4 NEWPROJ4 A2190 Installation of SA 40 1 19-Feb-18 19-Feb-18

NEWPROJ-4 NEWPROJ-4 A2200 Assembly of AHU Sections 40 1 20-Feb-18 20-Feb-18

NEWPROJ-4 NEWPROJ4 A2210 Fabrication and Installation of MS Pipe 40 1 21-Feb-18 21-Feb-18
and Valves

NEWPROJ-4 NEWPROJ-4  A2220 Installation of Cable Trays 40 1 22-Feb-18 22-Feb-18

NEWPROJ-4 NEWPROJ-4  A2230 Laying and Termination of Power Cables 40 1 23-Feb-18 23-Feb-18

NEWPROJ-4 NEWPROJ-4  A2240 Installation of VCD & FD in Supply & 40 1 26-Feb-18 26-Feb-18
Return Ducts

NEWPROJ-4 NEWPROJ-4  A2250 Installation of Humidifier 40 1 27-Feb-18 27-Feb-18

NEWPROJ-4 NEWPROJ4 A2260 Fabrication and Installation of Duct Work 40 1 28-Feb-18 28-Feb-18

NEWPROJ-4 NEWPROJ-4 A2280 Insulation of Duct work and Pipes 40 1 01-Mar-18 01-Mar-18

Total 1720

PPIC3 6 Electrical Items

NEWPROJ-4 NEWPROJ-4 A1100 Electrical Termination 40 1 08-Jan-18 08-Jan-18

NEWPROJ-4 NEWPROJ-4 A1130 Installation of Lights 40 1 11-Jan-18 11-Jan-18

NEWPROJ-4 NEWPROJ-4 A1140 Installation of Smoke Detector / 40 1 12-Jan-18 12-Jan-18
Sprinkler

NEWPROJ-4 NEWPROJ-4 A1220 Electrical Termination 40 1 08-Jan-18 08-Jan-18

NEWPROJ-4 NEWPROJ-4 A1250 Installation of Lights 40 1 11-Jan-18 11-Jan-18
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PPIC3 Final
Report Date 01-Jan-18 17:41

Project Start 01-Jan-18
Project Finish 26-Mar-18

RA-01 Resource Assignments, All Activities
User's Notes:

Resource Resource Name
Code
Project Code WBS Code Activity Code Activity Planned Units Planned Planned StartPlanned Finish
Duration
NEWPROJ-4 NEWPROJ-4 A1260 Installation of Smoke Detector / 40 1 12-Jan-18 12-Jan-18
Sprinkler
NEWPROJ-4 NEWPROJ-4 A1320 Electrical Termination 40 1 23-Jan-18 23-Jan-18
NEWPROJ-4 NEWPROJ-4 A1350 Installation of Lights 40 1 26-Jan-18 26-Jan-18
NEWPROJ-4 NEWPROJ-4 A1360 Installation of Smoke Detector / 40 1 29-Jan-18 29-Jan-18
Sprinkler
NEWPROJ-4 NEWPROJ-4 A1440 Electrical Termination 40 1 23-Jan-18 23-Jan-18
NEWPROJ-4 NEWPROJ-4 A1470 Installation of Lights 40 1 26-Jan-18 26-Jan-18
NEWPROJ-4 NEWPROJ4 A1480 Installation of Smoke Detector / 40 1 29-Jan-18 29-Jan-18
Sprinkler
NEWPROJ-4 NEWPROJ-4 A1550 Electrical Termination 40 1 08-Feb-18 08-Feb-18
NEWPROJ-4 NEWPROJ4 A1630 Installation of Cable Trays 40 1 06-Feb-18 06-Feb-18
NEWPROJ-4 NEWPROJ-4 A1640 Laying and Termination of Power Cables 40 1 07-Feb-18 07-Feb-18
NEWPROJ-4 NEWPROJ-4 A1750 Installation of Cable Trays 40 1 16-Feb-18 16-Feb-18
NEWPROJ-4 NEWPROJ-4 A1760 Laying and Termination of Power Cables 40 1 19-Feb-18 19-Feb-18
NEWPROJ-4 NEWPROJ-4 A1920 Installation of Cable Trays 40 1 08-Feb-18 08-Feb-18
NEWPROJ-4 NEWPROJ-4 A1930 Laying and Termination of Power Cables 40 1 09-Feb-18 09-Feb-18
NEWPROJ-4 NEWPROJ-4 A2070 Installation of Cable Trays 40 1 02-Mar-18 02-Mar-18
NEWPROJ-4 NEWPROJ-4 A2080 Laying and Termination of Power Cables 40 1 05-Mar-18 05-Mar-18
NEWPROJ-4 NEWPROJ-4  A2220 Installation of Cable Trays 40 1 22-Feb-18 22-Feb-18
NEWPROJ-4 NEWPROJ-4 A2230 Laying and Termination of Power Cables 40 1 23-Feb-18 23-Feb-18
NEWPROJ-4 NEWPROJ-4 A2380 Installation of Cable Trays 40 1 19-Mar-18 19-Mar-18
NEWPROJ-4 NEWPROJ-4 A2390 Laying and Termination of Power Cables 40 1 20-Mar-18 20-Mar-18
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PPIC3 Final
Report Date 01-Jan-18 17:41

Project Start 01-Jan-18
Project Finish 26-Mar-18

RA-01 Resource Assignments, All Activities
User's Notes:

Resource Resource Name
Code
Project Code WBS Code Activity Code Activity Planned Units Planned Planned StartPlanned Finish
Duration
1000
PPIC3 7 Duct & Pipe Insulation Material
NEWPROJ-4 NEWPROJ4 A1110 Insulation of Duct and Pipes 40 1 09-Jan-18 09-Jan-18
NEWPROJ-4 NEWPROJ4 A1230 Insulation of Duct and Pipes 40 1 09-Jan-18 09-Jan-18
NEWPROJ-4 NEWPROJ-4 A1330 Insulation of Duct and Pipes 40 1 24-Jan-18 24-Jan-18
NEWPROJ-4 NEWPROJ-4 A1450 Insulation of Duct and Pipes 40 1 24-Jan-18 24-Jan-18
NEWPROJ-4 NEWPROJ4 A1560 Insulation of Duct and Pipes 40 1 09-Feb-18 09-Feb-18
NEWPROJ-4 NEWPROJ4 A1660 Insulation of Duct work and Pipes 40 2 08-Feb-18 09-Feb-18
NEWPROJ-4 NEWPROJ4 A1810 Insulation of Duct work and Pipes 40 1 23-Feb-18 23-Feb-18
NEWPROJ-4 NEWPROJ4 A1980 Insulation of Duct work and Pipes 40 1 15-Feb-18 15-Feb-18
NEWPROJ-4 NEWPROJ-4 A2130 Insulation of Duct work and Pipes 40 1 09-Mar-18 09-Mar-18
NEWPROJ-4 NEWPROJ-4 A2280 Insulation of Duct work and Pipes 40 1 01-Mar-18 01-Mar-18
NEWPROJ-4 NEWPROJ-4 A2440 Insulation of Duct work and Pipes 40 1 26-Mar-18 26-Mar-18
440
PPIC3 8 Project Engineer
NEWPROJ-4 NEWPROJ-4 A1080 Ceiling Cutting / Dismantling & 40 3 01-Jan-18 03-Jan-18
Installation of FCU
NEWPROJ-4 NEWPROJ-4 A1090 Installation of Valves and MS Pipe 40 2 04-Jan-18 05-Jan-18
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PPIC3 Final
Report Date 01-Jan-18 17:41

Project Start 01-Jan-18
Project Finish 26-Mar-18

RA-01 Resource Assignments, All Activities
User's Notes:

Resource Resource Name

Code

Project Code WBS Code Activity Code Activity Planned Units Planned Planned StartPlanned Finish

Duration

NEWPROJ-4 NEWPROJ-4 A1100 Electrical Termination 40 1 08-Jan-18 08-Jan-18

NEWPROJ-4 NEWPROJ4 A1110 Insulation of Duct and Pipes 40 1 09-Jan-18 09-Jan-18

NEWPROJ-4 NEWPROJ-4 A1120 Ceiling / Ceiling Repairing 40 1 10-Jan-18 10-Jan-18

NEWPROJ-4 NEWPROJ-4 A1130 Installation of Lights 40 1 11-Jan-18 11-Jan-18

NEWPROJ-4 NEWPROJ-4 A1140 Installation of Smoke Detector / 40 1 12-Jan-18 12-Jan-18
Sprinkler

NEWPROJ-4 NEWPROJ-4 A1150 Linear Grill Alignment 40 1 15-Jan-18 15-Jan-18

NEWPROJ-4 NEWPROJ-4 A1300 Ceiling Cutting / Dismantling & 40 3 16-Jan-18 18-Jan-18
Installation of FCU

NEWPROJ-4 NEWPROJ-4 A1310 Installation of Valves and MS pipe 40 2 19-Jan-18 22-Jan-18
Connections

NEWPROJ-4 NEWPROJ4 A1320 Electrical Termination 40 1 23-Jan-18 23-Jan-18

NEWPROJ-4 NEWPROJ-4 A1330 Insulation of Duct and Pipes 40 1 24-Jan-18 24-Jan-18

NEWPROJ-4 NEWPROJ-4 A1340 Ceiling / Ceiling Repairing 40 1 25-Jan-18 25-Jan-18

NEWPROJ-4 NEWPROJ-4 A1350 Installation of Lights 40 1 26-Jan-18 26-Jan-18

NEWPROJ-4 NEWPROJ-4  A1360 Installation of Smoke Detector / 40 1 29-Jan-18 29-Jan-18
Sprinkler

NEWPROJ-4 NEWPROJ-4 A1370 Linear Grill Alignment 40 1 30-Jan-18 30-Jan-18

NEWPROJ-4 NEWPROJ-4 A1520 Hanging arrangement and Unit 40 3 31-Jan-18 02-Feb-18
Placement

NEWPROJ-4 NEWPROJ-4 A1530 Fabrication and Installation of Duct Work 40 1 05-Feb-18 05-Feb-18

NEWPROJ-4 NEWPROJ-4 A1540 Installation of Valves and MS Pipe 40 2 06-Feb-18 07-Feb-18
Connections

NEWPROJ-4 NEWPROJ-4 A1550 Electrical Termination 40 1 08-Feb-18 08-Feb-18
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PPIC3 Final
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Project Finish 26-Mar-18

RA-01 Resource Assignments, All Activities
User's Notes:

Resource Resource Name

Code

Project Code WBS Code Activity Code Activity Planned Units Planned Planned StartPlanned Finish
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NEWPROJ-4 NEWPROJ-4 A1560 Insulation of Duct and Pipes 40 1 09-Feb-18 09-Feb-18

NEWPROJ-4 NEWPROJ-4 A1700 Shifting of Unit at location 40 1 12-Feb-18 12-Feb-18

NEWPROJ-4 NEWPROJ-4 A1720 Installation of SA 40 1 13-Feb-18 13-Feb-18

NEWPROJ-4 NEWPROJ-4 A1730 Assembly of AHU Sections 40 1 14-Feb-18 14-Feb-18

NEWPROJ-4 NEWPROJ4 A1740 Fabrication and Installation of MS Pipe 40 1 15-Feb-18 15-Feb-18
and Valves

NEWPROJ-4 NEWPROJ-4 A1750 Installation of Cable Trays 40 1 16-Feb-18 16-Feb-18

NEWPROJ-4 NEWPROJ-4 A1760 Laying and Termination of Power Cables 40 1 19-Feb-18 19-Feb-18

NEWPROJ-4 NEWPROJ4 A1770 Installation of VCD & FD in Supply & 40 1 20-Feb-18 20-Feb-18
Return Ducts

NEWPROJ-4 NEWPROJ4 A1780 Installation of Humidifier 40 1 21-Feb-18 21-Feb-18

NEWPROJ-4 NEWPROJ4 A1790 Fabrication and Installation of Duct Work 40 1 22-Feb-18 22-Feb-18

NEWPROJ-4 NEWPROJ4 A1810 Insulation of Duct work and Pipes 40 1 23-Feb-18 23-Feb-18

NEWPROJ-4 NEWPROJ-4 A2020 Placment of Units at Foundation 40 1 26-Feb-18 26-Feb-18

NEWPROJ-4 NEWPROJ-4  A2040 Installation of SA 40 1 27-Feb-18 27-Feb-18

NEWPROJ-4 NEWPROJ-4  A2050 Assembly of AHU Sections 40 1 28-Feb-18 28-Feb-18

NEWPROJ-4 NEWPROJ-4 A2060 Fabrication and Installation of MS Pipe 40 1 01-Mar-18 01-Mar-18
and Valves

NEWPROJ-4 NEWPROJ-4 A2070 Installation of Cable Trays 40 1 02-Mar-18 02-Mar-18

NEWPROJ-4 NEWPROJ-4 A2080 Laying and Termination of Power Cables 40 1 05-Mar-18 05-Mar-18

NEWPROJ-4 NEWPROJ-4 A2090 Installation of VCD & FD in Supply & 40 1 06-Mar-18 06-Mar-18
Return Ducts

NEWPROJ-4 NEWPROJ-4 A2100 Installation of Humidifier 40 1 07-Mar-18 07-Mar-18

NEWPROJ-4 NEWPROJ-4 A2110 Fabrication and Installation of Duct Work 40 1 08-Mar-18 08-Mar-18
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User's Notes:
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NEWPROJ-4 NEWPROJ4 A2130 Insulation of Duct work and Pipes 40 1 09-Mar-18 09-Mar-18

NEWPROJ-4 NEWPROJ-4 A2320 Wall Dismantling 40 1 12-Mar-18 12-Mar-18

NEWPROJ-4 NEWPROJ-4 A2330 Shifting & Placement of Units on 40 1 13-Mar-18 13-Mar-18
Location

NEWPROJ-4 NEWPROJ-4 A2350 Installation of SA 40 1 14-Mar-18 14-Mar-18

NEWPROJ-4 NEWPROJ-4 A2360 Assembly of AHU Sections 40 1 15-Mar-18 15-Mar-18

NEWPROJ-4 NEWPROJ-4 A2370 Fabrication and Installation of MS Pipe 40 1 16-Mar-18 16-Mar-18
and Valves

NEWPROJ-4 NEWPROJ-4 A2380 Installation of Cable Trays 40 1 19-Mar-18 19-Mar-18

NEWPROJ-4 NEWPROJ-4  A2390 Laying and Termination of Power Cables 40 1 20-Mar-18 20-Mar-18

NEWPROJ-4 NEWPROJ-4  A2400 Installation of VCD & FD in Supply & 40 1 21-Mar-18 21-Mar-18
Return Ducts

NEWPROJ-4 NEWPROJ-4 A2410 Installation of Humidifier 40 1 22-Mar-18 22-Mar-18

NEWPROJ-4 NEWPROJ-4 A2420 Fabrication and Installation of Duct Work 40 1 23-Mar-18 23-Mar-18

NEWPROJ-4 NEWPROJ-4 A2440 Insulation of Duct work and Pipes 40 1 26-Mar-18 26-Mar-18

Total 2080

PPIC3 9 Project Manager

NEWPROJ-4 NEWPROJ-4 A1180 Ceiling Cutting / Dismantling & 40 3 01-Jan-18 03-Jan-18
Installation of FCU

NEWPROJ-4 NEWPROJ-4 A1210 Installation of Valves and MS Pipe 40 2 04-Jan-18 05-Jan-18
Connections

NEWPROJ-4 NEWPROJ-4 A1220 Electrical Termination 40 1 08-Jan-18 08-Jan-18
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Report Date 01-Jan-18 17:41

User's Notes:

RA-01 Resource Assignments, All Activities

Project Start 01-Jan-18
Project Finish 26-Mar-18

Resource Resource Name

Code

Project Code WBS Code Activity Code Activity Planned Units Planned Planned StartPlanned Finish

Duration

NEWPROJ-4 NEWPROJ-4 A1230 Insulation of Duct and Pipes 40 1 09-Jan-18 09-Jan-18

NEWPROJ-4 NEWPROJ-4 A1240 Ceiling / Ceiling Repairing 40 1 10-Jan-18 10-Jan-18

NEWPROJ-4 NEWPROJ-4 A1250 Installation of Lights 40 1 11-Jan-18 11-Jan-18

NEWPROJ-4 NEWPROJ-4 A1260 Installation of Smoke Detector / 40 1 12-Jan-18 12-Jan-18
Sprinkler

NEWPROJ-4 NEWPROJ-4 A1270 Linear Grill Alignment 40 1 15-Jan-18 15-Jan-18

NEWPROJ-4 NEWPROJ-4 A1400 Ceiling Cutting / Dismantling & 40 3 16-Jan-18 18-Jan-18
Installation of FCU

NEWPROJ-4 NEWPROJ4 A1430 Installation of Valves and MS Pipe 40 2 19-Jan-18 22-Jan-18
Connections

NEWPROJ-4 NEWPROJ-4 A1440 Electrical Termination 40 1 23-Jan-18 23-Jan-18

NEWPROJ-4 NEWPROJ-4 A1450 Insulation of Duct and Pipes 40 1 24-Jan-18 24-Jan-18

NEWPROJ-4 NEWPROJ-4 A1460 Ceiling / Ceiling Repairing 40 1 25-Jan-18 25-Jan-18

NEWPROJ-4 NEWPROJ-4 A1470 Installation of Lights 40 1 26-Jan-18 26-Jan-18

NEWPROJ-4 NEWPROJ-4 A1480 Installation of Smoke Detector / 40 1 29-Jan-18 29-Jan-18
Sprinkler

NEWPROJ-4 NEWPROJ-4 A1490 Linear Grill Alignment 40 1 30-Jan-18 30-Jan-18

NEWPROJ-4 NEWPROJ-4 A1600 Shifting and Placement of Units on 40 1 31-Jan-18 31-Jan-18
Foundations at Roof

NEWPROJ-4 NEWPROJ-4 A1610 Duct Work 40 2 01-Feb-18 02-Feb-18

NEWPROJ-4 NEWPROJ-4 A1620 Copper Piping 40 1 05-Feb-18 05-Feb-18

NEWPROJ-4 NEWPROJ-4 A1630 Installation of Cable Trays 40 1 06-Feb-18 06-Feb-18

NEWPROJ-4 NEWPROJ-4 A1640 Laying and Termination of Power Cables 40 1 07-Feb-18 07-Feb-18

NEWPROJ-4 NEWPROJ-4 A1660 Insulation of Duct work and Pipes 40 2 08-Feb-18 09-Feb-18
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NEWPROJ-4 NEWPROJ4 A1860 Shifting of Unit at location 40 1 01-Feb-18 01-Feb-18

NEWPROJ-4 NEWPROJ4 A1880 Installation of SA 40 1 02-Feb-18 02-Feb-18

NEWPROJ-4 NEWPROJ-4 A1890 Shifting & Placement of Units on 40 1 05-Feb-18 05-Feb-18
Location

NEWPROJ-4 NEWPROJ-4 A1900 Assembly of AHU Sections 40 1 06-Feb-18 06-Feb-18

NEWPROJ-4 NEWPROJ4 A1910 Fabrication and Installation of MS Pipe 40 1 07-Feb-18 07-Feb-18
and Valves

NEWPROJ-4 NEWPROJ4 A1920 Installation of Cable Trays 40 1 08-Feb-18 08-Feb-18

NEWPROJ-4 NEWPROJ-4  A1930 Laying and Termination of Power Cables 40 1 09-Feb-18 09-Feb-18

NEWPROJ-4 NEWPROJ-4 A1940 Installation of VCD & FD in Supply & 40 1 12-Feb-18 12-Feb-18
Return Ducts

NEWPROJ-4 NEWPROJ-4 A1950 Installation of Humidifier 40 1 13-Feb-18 13-Feb-18

NEWPROJ-4 NEWPROJ4 A1960 Fabrication and Installation of Duct Work 40 1 14-Feb-18 14-Feb-18

NEWPROJ-4 NEWPROJ-4 A1980 Insulation of Duct work and Pipes 40 1 15-Feb-18 15-Feb-18

NEWPROJ-4 NEWPROJ-4 A2170 Shifting & Placement of Units on 40 1 16-Feb-18 16-Feb-18
Location

NEWPROJ-4 NEWPROJ-4 A2190 Installation of SA 40 1 19-Feb-18 19-Feb-18

NEWPROJ-4 NEWPROJ-4  A2200 Assembly of AHU Sections 40 1 20-Feb-18 20-Feb-18

NEWPROJ-4 NEWPROJ-4 A2210 Fabrication and Installation of MS Pipe 40 1 21-Feb-18 21-Feb-18
and Valves

NEWPROJ-4 NEWPROJ-4 A2220 Installation of Cable Trays 40 1 22-Feb-18 22-Feb-18

NEWPROJ-4 NEWPROJ-4 A2230 Laying and Termination of Power Cables 40 1 23-Feb-18 23-Feb-18

NEWPROJ-4 NEWPROJ-4 A2240 Installation of VCD & FD in Supply & 40 1 26-Feb-18 26-Feb-18
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User's Notes:

Resource Resource Name

Code

Project Code WBS Code Activity Code Activity Planned Units Planned Planned StartPlanned Finish
Duration

NEWPROJ-4 NEWPROJ-4 A2250 Installation of Humidifier 40 1 27-Feb-18 27-Feb-18

NEWPROJ-4 NEWPROJ4 A2260 Fabrication and Installation of Duct Work 40 1 28-Feb-18 28-Feb-18

NEWPROJ-4 NEWPROJ4 A2280 Insulation of Duct work and Pipes 40 1 01-Mar-18 01-Mar-18

Total 1720

# Oracle Primavera

Page 15 of 15
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Real Case (Progress till 07th January 2018)

This S-Curve is based on real progress. The following mentioned activities are executed

till date. [7]

Training Room 1 - FCU

A1080

A1090

Ceiling Cutting / Dismantling & Installation of FCU

Installation of Valves and MS Pipe Connections

The Following Activities are executed parallel to the above mentioned activities

Training Room 2 - FCU

A1180

A1210

ol
Allec2e |

Ceiling Cutting / Dismantling & Installation of FCU

Installation of Valves and MS Pipe Connections

Fiter. All Activities B -
Dec 31 Jan 07 Jan 14 Jan21 Jan 28 | -~
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Figure 3: S Curve (Actual)
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Resource Usage Profile:
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Figure 4: S Curve (Resource Usage Profile)

Activity Usage Profile:

= Digplay: Open Projects Only
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Figure 5: S Curve (Activity Usage Profile)
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Table F: Results obtained from Primavera [8]

Project Budget (BAC) 376,220,000.00
Planned Value (PV) 5,280,000.00
Earned Value (EV) 5,280,000.00
Actual cost (AC) 5,280,000.00
Schedule Variance (SV) = EV-PV 0

SV % = SV/PV 0

Schedule Performance Index (SPI)= EV/PV 1

Total Duration 61 DayS

Cost variance CV=EV-AC 0

CV%=CV/EV 0

Cost performance index CPI=EV/AC 1

Estimate to complete 370940000
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(What-If Scenarios)

1) Assumed Scenario (Best Case)

This S-Curve is based on assumed scenario (The Best one), in which we are meeting
our time & there is too much lead. This scenario is based on activities from January 01st,
2018 to January 16th, 2018.

The following Activities are executed till January 16th, 2018

Training Room 1 - FCU

A1080

A1090

A1100

A1110

A1120

A1130

A1140

A1150

Ceiling Cutting / Dismantling & Installation of FCU
Installation of Valves and MS Pipe Connections
Electrical Termination

Insulation of Duct and Pipes

Ceiling / Ceiling Repairing

Installation of Lights

Installation of Smoke Detector / Sprinkler

Linear Grill Alignment

The Following Activities are executed parallel to the above mentioned activities

Training Room 2 - FCU

A1180

A1210

A1220

A1230

A1240

A1250

A1260

Ceiling Cutting / Dismantling & Installation of FCU
Installation of Valves and MS Pipe Connections
Electrical Termination

Insulation of Duct and Pipes

Ceiling / Ceiling Repairing

Installation of Lights

Installation of Smoke Detector / Sprinkler
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A1270 Linear Grill Alignment

I ++ Display: Open Projects Only
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Figure 6: S Curve (Best Case)
Results:

The BCWS, BCWP, ACWP, BAC, ETC, EAC & VAC report for the said case (Generated
by using Primavera P6) is attached.
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2) Assumed Scenario (Worst Case)

This S-Curve is based on assumed scenario (The worst one), in which we are not
meeting our time & there is too much lag. This scenario is based on activities from
January 01st, 2018 to January 16th, 2018.

The following Activities are executed till January 16th, 2018

Training Room 1 —

A1080

A1090

A1100

A1110

A1120

A1130

A1140

A1150

Fcu

Ceiling Cutting / Dismantling & Installation of FCU
Installation of Valves and MS Pipe Connections
Electrical Termination

Insulation of Duct and Pipes

Ceiling / Ceiling Repairing

Installation of Lights

Installation of Smoke Detector / Sprinkler

Linear Grill Alignment

The Following Activities are executed parallel to the above mentioned activities

Training Room 2 —

A1180

A1210

A1220

A1230

A1240

A1250

A1260

A1270

Fcu

Ceiling Cutting / Dismantling & Installation of FCU
Installation of Valves and MS Pipe Connections
Electrical Termination

Insulation of Duct and Pipes

Ceiling / Ceiling Repairing

Installation of Lights

Installation of Smoke Detector / Sprinkler

Linear Grill Alignment
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Figure 7: S Curve (Worst Case)

Results:

The BCWS, BCWP, ACWP, BAC, ETC, EAC & VAC report for the said case (Generated
by using Primavera P6) is attached.
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Conclusions

At the present time, owners of huge businesses and contractors simultaneously
manage and control several engineering and construction projects. These big
projects are linked rings of a chain. Insisting on finishing the project on the
determined time, considering no financial limitations and maintaining the position
in competitive market lead to an increase in applying project management
knowledge. Hence, it is necessary for project managers to move from a traditional
structure to a simple and efficient multi-project organizational structure. Optimal
use of resources increasingly becomes more sensitive and challenges managers'
minds.

Planning, monitoring and controlling, as well as the need and effectiveness of
project management software like Primavera P6 in a construction projective of
this study was to understand the role of monitoring and control in the progress
and timely completion of a construction project.

The organization has found that monitoring and tracking project using software is
useful to keep a more precise watch on the contractor’s performance.

It helps easily prepare and control project things to do.

It optimizes management off resources.

It offers clear field of vision of what’s taking in the particular project.

It allows quick and easy forecasting connected with WBS's, things to do or
assignments.



PPIC3 Final

Report Date 07-Jan-18 12:29

AC-01 Activity Earned Value

Project Start 01-Jan-18
Project Finish 26-Mar-18

WBS
Activity ID Activity Name Activity BCWsS BCWP ACWP BAC ETC EAC VAC
Status
MECSOL MECSOL EPS
Civil PPIC3 Lahore
NEWPROJ-4 PPIC3 Final

A1070 Training Room 1- FCU : Not Started PKRO0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00

A1080 Ceiling Cutting / Dismantling & Completed KR7,260,000.00 KR7,260,000.00 5,445,000.00 KR7,260,000.00 PKR0.00 KR5,445,000.00 21,815,000.00
Installation of FCU

A1090 Installation of Valves and MS Completed PKR60,000.00 PKR60,000.00 *KR30,000.00 PKR60,000.00 PKR0.00 PKR30,000.00 ”KR30,000.00
Pipe Connections

A1100 Electrical Termination Completed PKR460,000.00 PKR460,000.00 KR460,000.00 PKR460,000.00 PKR0.00 PKR460,000.00 PKR0.00

A1110 Insulation of Duct and Pipes Completed PKR860,000.00 PKR860,000.00 KR860,000.00 PKR860,000.00 PKR0.00 PKR860,000.00 PKR0.00

A1120 Ceiling / Ceiling Repairing Completed PKR60,000.00 PKR60,000.00 >KR60,000.00 PKR60,000.00 PKR0.00  PKR60,000.00 PKR0.00

A1130 Installation of Lights Completed PKR460,000.00 PKR460,000.00 KR460,000.00 PKR460,000.00 PKR0.00 PKR460,000.00 PKR0.00

A1140 Installation of Smoke Detector /  Completed PKR460,000.00 PKR460,000.00 KR460,000.00 PKR460,000.00 PKR0.00 PKR460,000.00 PKR0.00
Sprinkler

A1150 Linear Grill Alignment Completed PKR60,000.00 PKR60,000.00 >KR60,000.00 PKR60,000.00 PKR0.00  PKR60,000.00 PKR0.00

A1160 Nespak Inspection and Approval  Not Started PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00

A1170 Training Room 2- FCU : Not Started PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00

A1180 Ceiling Cutting / Dismantling & Completed KR7,300,000.00 KR7,300,000.00 5,475,000.00 KR7,300,000.00 PKR0.00 KR5,475,000.00 31,825,000.00
Installation of FCU

A1210 Installation of Valves and MS Completed PKR100,000.00 PKR100,000.00 >KR50,000.00 PKR100,000.00 PKR0.00 PKR50,000.00 ”KR50,000.00
Pipe Connections

A1220 Electrical Termination Completed PKR500,000.00 PKR500,000.00 KR500,000.00 PKR500,000.00 PKR0.00 PKR500,000.00 PKR0.00

A1230 Insulation of Duct and Pipes Completed PKR900,000.00 PKR900,000.00 KR900,000.00 PKR900,000.00 PKR0.00 PKR900,000.00 PKR0.00

A1240 Ceiling / Ceiling Repairing Completed PKR100,000.00 PKR100,000.00 KR100,000.00 PKR100,000.00 PKR0.00 PKR100,000.00 PKR0.00

A1250 Installation of Lights Completed PKR500,000.00 PKR500,000.00 KR500,000.00 PKR500,000.00 PKR0.00 PKR500,000.00 PKR0.00

A1260 Installation of Smoke Detector /  Completed PKR500,000.00 PKR500,000.00 KR500,000.00 PKR500,000.00 PKR0.00 PKR500,000.00 PKR0.00
Sprinkler

A1270 Linear Grill Alignment Completed PKR100,000.00 PKR100,000.00 KR100,000.00 PKR100,000.00 PKR0.00 PKR100,000.00 PKR0.00

A1280 Nespak Inspection and Approval  Not Started PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00

A1290 DiningArea - FCU : Not Started PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00

A1300 Ceiling Cutting / Dismantling & Not Started PKR0.00 PKR0.00 PKR0.00 KR7,260,000.00 KR7,260,000.00 KR7,260,000.00 PKR0.00
Installation of FCU

A1310 Installation of Valves and MS pipe Not Started PKR0.00 PKR0.00 PKR0.00 PKR60,000.00 PKR60,000.00 PKR60,000.00 PKR0.00
Connections

A1320 Electrical Termination Not Started PKR0.00 PKR0.00 PKR0.00 PKR460,000.00 PKR460,000.00 PKR460,000.00 PKR0.00

A1330 Insulation of Duct and Pipes Not Started PKR0.00 PKR0.00 PKR0.00 PKR860,000.00 PKR860,000.00 PKR860,000.00 PKR0.00

A1340 Ceiling / Ceiling Repairing Not Started PKR0.00 PKR0.00 PKR0.00 PKR60,000.00 PKR60,000.00 PKR60,000.00 PKR0.00

A1350 Installation of Lights Not Started PKR0.00 PKR0.00 PKR0.00 PKR460,000.00 PKR460,000.00 PKR460,000.00 PKR0.00

© Primavera Systems, Inc.
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Report Date 07-Jan-18 12:40

AC-01 Activity Earned Value

Project Start 01-Jan-18
Project Finish 26-Mar-18

WBS
Activity ID Activity Name Activity BCWsS BCWP ACWP BAC ETC EAC VAC
Status
MECSOL MECSOL EPS
Civil PPIC3 Lahore
NEWPROJ-4 PPIC3 Final

A1070 Training Room 1- FCU : Not Started PKRO0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00

A1080 Ceiling Cutting / Dismantling & Completed KR7,260,000.00 KR7,260,000.00 10,890,000.00 KR7,260,000.00 PKR0.00 R10,890,000.00 .3,630,000.00)
Installation of FCU

A1090 Installation of Valves and MS Completed PKR60,000.00 PKR60,000.00 *KR75,000.00 PKR60,000.00 PKR0.00 PKR75,000.00 'KR15,000.00)
Pipe Connections

A1100 Electrical Termination Completed PKR460,000.00 PKR460,000.00 KR460,000.00 PKR460,000.00 PKR0.00 PKR460,000.00 PKR0.00

A1110 Insulation of Duct and Pipes Completed PKR860,000.00 PKR860,000.00 1,720,000.00 PKR860,000.00 PKR0.00 KR1,720,000.00 {R860,000.00)

A1120 Ceiling / Ceiling Repairing Completed PKR60,000.00 PKR60,000.00 >KR60,000.00 PKR60,000.00 PKR0.00  PKR60,000.00 PKR0.00

A1130 Installation of Lights Completed PKR460,000.00 PKR460,000.00 KR460,000.00 PKR460,000.00 PKR0.00 PKR460,000.00 PKR0.00

A1140 Installation of Smoke Detector /  Completed PKR460,000.00 PKR460,000.00 KR460,000.00 PKR460,000.00 PKR0.00 PKR460,000.00 PKR0.00
Sprinkler

A1150 Linear Grill Alignment Completed PKR60,000.00 PKR60,000.00 KR120,000.00 PKR60,000.00 PKR0.00 PKR120,000.00 'KR60,000.00)

A1160 Nespak Inspection and Approval  Not Started PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00

A1170 Training Room 2- FCU : Not Started PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00

A1180 Ceiling Cutting / Dismantling & Completed KR7,300,000.00 KR7,300,000.00 5,475,000.00 KR7,300,000.00 PKR0.00 KR5,475,000.00 31,825,000.00
Installation of FCU

A1210 Installation of Valves and MS Completed PKR100,000.00 PKR100,000.00 KR150,000.00 PKR100,000.00 PKR0.00 PKR150,000.00 'KR50,000.00)
Pipe Connections

A1220 Electrical Termination Completed PKR500,000.00 PKR500,000.00 1,000,000.00 PKR500,000.00 PKR0.00 KR1,000,000.00 {R500,000.00)

A1230 Insulation of Duct and Pipes Completed PKR900,000.00 PKR900,000.00 KR900,000.00 PKR900,000.00 PKR0.00 PKR900,000.00 PKR0.00

A1240 Ceiling / Ceiling Repairing Completed PKR100,000.00 PKR100,000.00 KR100,000.00 PKR100,000.00 PKR0.00 PKR100,000.00 PKR0.00

A1250 Installation of Lights Completed PKR500,000.00 PKR500,000.00 KR500,000.00 PKR500,000.00 PKR0.00 PKR500,000.00 PKR0.00

A1260 Installation of Smoke Detector /  Completed PKR500,000.00 PKR500,000.00 1,000,000.00 PKR500,000.00 PKR0.00 KR1,000,000.00 {R500,000.00)
Sprinkler

A1270 Linear Grill Alignment Completed PKR100,000.00 PKR100,000.00 KR200,000.00 PKR100,000.00 PKR0.00 PKR200,000.00 {R100,000.00)

A1280 Nespak Inspection and Approval  Not Started PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00

A1290 DiningArea - FCU : Not Started PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00 PKR0.00

A1300 Ceiling Cutting / Dismantling & Not Started PKR0.00 PKR0.00 PKR0.00 KR7,260,000.00 KR7,260,000.00 KR7,260,000.00 PKR0.00
Installation of FCU

A1310 Installation of Valves and MS pipe Not Started PKR0.00 PKR0.00 PKR0.00 PKR60,000.00 PKR60,000.00 PKR60,000.00 PKR0.00
Connections

A1320 Electrical Termination Not Started PKR0.00 PKR0.00 PKR0.00 PKR460,000.00 PKR460,000.00 PKR460,000.00 PKR0.00

A1330 Insulation of Duct and Pipes Not Started PKR0.00 PKR0.00 PKR0.00 PKR860,000.00 PKR860,000.00 PKR860,000.00 PKR0.00

A1340 Ceiling / Ceiling Repairing Not Started PKR0.00 PKR0.00 PKR0.00 PKR60,000.00 PKR60,000.00 PKR60,000.00 PKR0.00

A1350 Installation of Lights Not Started PKR0.00 PKR0.00 PKR0.00 PKR460,000.00 PKR460,000.00 PKR460,000.00 PKR0.00

© Primavera Systems, Inc.
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Table F: CBT LOG (Fahad Arif)
S/N Issue Description Solution Source
New activity added Right click on activity , select
through right click , how L , o YouTube
1 . . activity details , details will .
to add information of Video
- show at the end of screen
activity
Activity network was not Click on zoom button at the
2 Internet
shown bottom of the screen
Problem in defining click pn activity and click in
3 ) : L assign predecessor and Teacher
relationship of activities
successor
How to apply unit of time Edit>User preferences> time .
. . Primavera
4 on layout from user units Edit> User preferences> .
. User Guide
preferences? dates, check time
Activity network was not
5 showing the blue bar Manually dragging it Teacher
after finishing the activity
Click on activity then select
6 Assigning resources to resource to open gdd resources Slideshare
concerned activities option for assigning resources
for the activity
Choose Enterprise, Resource
Codes> Click Modify>Select
the resource code you want to
edit>To change the resource
Difficulty in Editing code’s name, type a new _
2 Resource Code name>To change the maximum Prlmavgra
number of characters the User Guide

code's values may have,
specify a new number>To
change the placement of the
code in the list, click Shift Up or
Shift Down>Click Close.
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Choosing Industry
option after installation of
P6

PRIMAVERA CBT

Go to admin then admin
preferences go to industry
option to select the required
industry

Classmate

Different Techniques for
computing performance
percentage

By going to project then WBS
option for selecting desirable
technique

Teacher

10

Automatic update in
scheduling and leveling

Mark the schedule so that it
updates Automatically when a
change affects dates check box

in the General tab of the
schedule option dialog box to
recalculate the schedule each
time a significant change is
made to an activity, relationship
or resource.

Primavera
User Guide

11

Enter multiple resource
prices over time

1) Choose Enterprise,
Resources>Select the resource
whose prices you want to
enter>Click the Units & Prices
tab>Repeat the following to
assign dates with different
price/units to the resource: a.
Click Add>To change the
price's effective date, double-
click the Effective Date field,
click , then select a new
date>Type the maximum
number of time units the
resource can perform, followed
by a forward slash (/) and the
appropriate time duration

Primavera
User Guide

12

Change an activity's work
breakdown structure
assignment

1) Choose Project,
Activities>Select the activity
whose WBS assignment you

want to define or
change>Display Activity
Details, then click the General
tab.

Internet
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1) Choose Enterprise,
Enterprise Project Structure>

Youtube

13 Set up the EPS structure Click the EPS Name column .
Video
where you want to add a new
element>Click Add
1) Choose Enterprise, Projects,
Delete an EPS node or th_en select the EPS node or
14 roiect project that you want to delete. Teacher
prol Choose Edit, Delete> Click Yes
to confirm
Choose Project, WBS, then
15 Display work breakdown | choose View, Show on Bottom, Teacher
structure details Details.
Table G: CBT LOG (Muhammad Safdar)
Time Taken to
S/IN Issue Description Get the Solution Source
Solution
Go to Display Option
Bar Choose Show on YouTube
1 Viewing a WBS 10min top WBS Table. To list Video
and sort WBS
elements.
In Perceiving the . Accessed by C“Ck'.ng
2 . 10min Group and sort option Internet
basis of Group
form the menu bar
Project was not
Directory Bar was . selected from Project
3 ) 14min . Internet
disabled button on projects
directly bar
D|ff|cult¥ n . Creating a new EPS YouTube
4 understanding the 20min and Proiect in EPS Video
EPS hierarchy and J
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level from Project
View
Difficulty in G.o to Activity right
Understanding the click on layout and
5 . 9 5min Expand Global and Teacher
Classis WBS )
select Classis WBS
Layout
layout
Progress schedule Weekly progress
6 % complete was 22min established by going to Teacher
not shown tool> update progress
Problem in defining click on zoom button at | Slideshare
relationship of 16min the bottom of the slide
activities screen presentation
Difficulty in Edit User>Preferences
applying unit of . >time units Edit>User Primavera
. 20min :
time on layout from preferences>dates, Help Guide
user preferences check time
Project>Select Assign
How to Assign the Basel.lne> Project
: . Baseline> Ok and
9 Baseline, and 3min . Classmate
. Project> select
update Baseline L
Maintain
baseline>Add>close
Resources are defined
by accessing
resources tab. Then
How Resources is each activity can be
10 assigned to an 13min assigned any resource Teacher
activity by going to Activities
,selecting the activity
and loading a resource
on it.
Edit >dissolve in the
activity
11 Dissolving the 29min window>dissolve Primavera
Activates deletes an activity and Help Guide

joins its predecessor

and successor
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activities with a finish
to start relationship.

12

Assigning/Defining
Resource shifts

14min

Go to Enterprise
Resource shifts. Click
Add and then type
name of the new shift.
To edit the new shift
click Modify

Teacher

13

Defining Resources

23min

Click on the
Enterprises and open
resources option then

use add for defining
resources with their
wages as well

Teacher

14

Resource Leveling

15min

Open the Project that
contain the resources
we want to level. Click
on the Tool and then
Level Resources.

Primavera
Help Guide

15

Defining
Activity/Resource
code

12min

Selecting Enterprise to
select Resource and
activity code to add

codes for each domain

Primavera
Help Guide

16

Difficulty Adding
Cost Variance
Columns

11min

View>columns>Earned
Value>Select
CV>Add>Ok>Apply

Primavera
Help Guide
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